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1. Introduction to your Website 
Your website is based on a Content Management System (CMS) called Joomla! which 
is an expansive and open-source platform for publishing web content. Over the years 
Joomla! has won several awards and allows you to build powerful online applications. 

Joomla! is one of the most popular website softwares, thanks to its global community 
of developers and volunteers, who make sure the platform is secure, user friendly, 
extendable, multilingual, accessible, responsive, search engine optimized and so 
much more. 

1.1 What's a content management system (CMS)? 

The definition of a CMS is an application (web-based), that provides capabilities for 
multiple users with different permission levels to manage (all or a section of) content, 
data or information of a website project, or intranet application. Managing content 
refers to creating, editing, archiving, publishing, collaborating on, reporting, 
distributing website content, data, and information. 

1.1.1 Why did we choose Joomla? 

Tapiochre develop websites for schools and as such we believe Joomla! is the perfect 
tool for the job as it is designed to be easy to install and set up, even if you're not an 
advanced user. With a short learning curve (we provide all sorts of training as well) 
you’ll be able to quickly understand how to keep your website up to date with the 
right content. With a minimal amount of instruction, we hope to empower you to 
easily manage your own website yourself. 

  

https://docs.joomla.org/Special:MyLanguage/Joomla!_Awards
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2. Getting to Grips with your Website 
This section explains the basic concepts of your Joomla website. After you’ve finished 
this section, you’ll understand how users see your site and how administrators like 
you manage your site and you’ll be able to: 

• Understand the two areas of your Joomla site. 
• Understand the visitor area of your Joomla site. 
• Understand the administrator area of your Joomla site. 
• Make your first Joomla site changes. 

2.1 Understanding the two areas of a Joomla site. 

Every Joomla Web site has two areas: a public area for visitors, also known as the 
Front End and a private area for administrators, also known as the Control Panel or 
the Administrator area. 

2.1.1 Visitor (Front End) Area 

Absolutely everything you want visitors to see on your site can be accessed from here 
- basically, this is your website! You can always access the visitor area simply by 
visiting the web address for your website. Type in the web address, and you will see 
the home page of your site. 

2.1.2 Control Panel or Administrator Area 

The other half of your site is the secure or private area for administrators. Absolutely 
everything you want to change about your site can be changed from here. It is called 
the Control Panel of your site as that is where you control everything; where you go 
to add, remove, and change content, create navigation, or modify your site layout. 

We cover logging in in our Fundamentals area of this guide here which is the next 
stage! 

https://itlookslikethis.co.uk/web2/index.php/getting-started-2/administrator-login
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2.2 Administrator Login 

To perform the advanced features of working on the website you will need to log into 
the Control Panel of the website. To login to the Control Panel of your website, you 
will need to access the secured area of the site. 

To start, your website URL will be something like: 

https://www.myschoolname.org.uk 

When you need to log into the website Control Panel, you simply add the 
/administrator path so, using our example, the full URL for logging on will be: 

https://www.myschoolname.org.uk/administrator 

When you go to this URL, you will be presented with a login window: 

 

 

Enter your username and your password (remember the password is case sensitive) 
and click “Log In” to reach the Control Panel home page from where you will be able 
to perform the necessary tasks needed to manage your site. 

https://www.myschoolname.org.uk/
https://www.myschoolname.org.uk/administrator
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2.2.1 Control Panel Warnings and Notices 

From time to time, when you access the Control Panel you might see notifications 
about Updates: 

 

2.2.2 What to do? 

In general, these updates should only be performed if you are completely confident 
that the updates are necessary. We recommend that you leave these updates to us 
as part of our Service Level Agreement with you. We are notified daily about updates 
that are available for websites. We normally wait a week or two for others to 
thoroughly test these updates before we apply them. 
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3. The Control Panel 
Once logged in, you can perform tasks to manage the website. You do this via the 
Control Panel of the website. 

The Control Panel provides access to website functions and features by giving you a 
drop-down menu bar, a general notification area, and a handful of clickable icons. 

3.1 Joomla 3 vs Joomla 4 Control Panels 

With the updates to Joomla 4 progressing nicely, some websites will now show the 
Joomla 4 control panel. Below we look at both views but if you want to see the 
Joomla 4 information see later in this page. 

3.1.1 Joomla 3 Control Panel of your website 

 

The above is a Joomla 3 control panel example. 

On every page of your Joomla 3 control panel area of your site, you’ll always see a 
dropdown menu that’s shown below. This top menu has all the key links you need to 
manage your site: 
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You will also see quick links in the lefthand sidebar in Joomla 3. 

These links might help you to navigate to certain areas of the control panel as needed 
but in this guide, we always refer to the top menu for Joomla 3 because all options 
we use are available from the top menu. When you hover your mouse over the 
dropdown menu, and you’ll see dropdown links, and these are used throughout this 
guide, and we cover all necessary choices in the relevant section. 

3.1.2 Joomla 4 Control Panel of your website  

  

With Joomla 4, (and future versions like Joomla 5), the Control Panel is very different 
as you can see. Where in Joomla 3 the menu was across the top of the page, in 
Joomla 4 these same options are shown vertically down the left of the page. They 
serve the same purpose as in Joomla 3 but are aligned this way which, by virtue of 
the upgrade to version 4 also makes the Control Panel much more mobile friendly! 
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3.2 Control Panel Menus 

Because the dropdown menu is so important, we base this entire guide on it. Every 
time we ask you to visit a page in the Control Panel area, we go via this dropdown 
menu. The dropdown menu contains the following most accessed options: 

 

Joomla 3 Control Panel menu 

 

Joomla 4 Control Panel menu 

 

 

3.2.1 Who are the menu items for? 
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Menu Item Accessible to Predominant User 

Joomla Icon  All Admins All 

System Tapiochre Tapiochre 

Users All Admins All 

Menus All Admins All 

Content All Admins All 

Components All Admins All with some exceptions 

Extensions All Admins All with some exceptions 

Help All Admins All 

SPPage Builder All Admins (Selected Websites 
only) 

All 

3.2.2 Joomla Icon  

Use this icon to return to the main control panel home page. This is active when you 
are not editing something. 

3.2.3 System  

Contains all the main configuration options for your site. The good news is that most 
of these configuration options will be set up correctly when you first use your site 
your site so it's unlikely you will need to visit this option. 

3.2.4 Users  

This is where you can create and give different permissions to different users and 
groups of users. 
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3.2.5 Menus  

Contains the website navigation for your visitors. You might call them 'Tabs’, but their 
correct terminology is menu links and you click on them in the front-end area of the 
site to move from page to page. 

3.2.6 Content  

Contains all your text articles. Any text that you write in articles goes here, from 
news, information and blog posts to document lists and image galleries; all of these 
are created from within the Content > Articles menu. 

3.2.7 Components  

These the main extra features you can add and manage in your site. Photo galleries, 
event calendars, contact forms, document management and weblinks are all 
controlled from here so that you can add them as menu choices or as content in your 
webpages. 

3.2.8 Extensions  

The Extensions dropdown menu includes links to the following types of extension: 

Modules. Modules are the boxes found around the perimeter of your site. They show 
visitors little snippets of information, such as files, websites, or page lists (among 
many other cool content ideas), normally related to what is seen in the main body of 
the webpage. 

Plug-ins. Plug-ins are little programs that make subtle improvements to your site. You 
don't ususally 'interact' with plugins, they work in the background to make special 
features happen. 

Templates. Templates are the design and layout of your site. You will never need to 
change the settings in the template choice but when WE need to make changes, this 
is where we do it! 
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4. Categories 

4.1 Introduction 

Categories are an important part of your website because they help you to organize 
your content into logical groups. They are used in several different areas of the 
website and an easy way to think of a category - no matter where you encounter it - 
is as a ‘folder’ and an analogy is to consider categories to be a way to organise and 
group things together so that they can be found and displayed more easily and 
managed together in a logical way on the website. 

Areas that use Categories include articles, weblinks, documents, contacts and so on. 
Category names can be anything that makes sense to you and once created, you can 
associate things with them. You can change Category names at any time you wish, 
and you can move things to be in different categories whenever you want to. 

Once you have your categories set up, you can start creating content and assigning it 
to categories. For example, if you create a blog post, you can assign it to a category 
that you perhaps called “Blogs”. This makes it easy for your website visitors to find 
content that is relevant to their interests.  

Joomla also allows you to create menu items (see our section on Menus) that link to 
categories. This means you can create a navigation menu that allows your website 
visitors to easily access all the content in a particular category. For example, you 
might create a menu item that links to the "News" category. When a website visitor 
clicks on that menu item, they will see a list of all the posts that have been assigned 
to the "News" category. 

Categorising things and creating an organisational structure for your content is the 
best way to help you manage the site. 

4.2 Where do we see Categories in use? 

As outlined above, (among other areas) categories are mostly used for for Articles, 
Weblinks, Contacts, Diary/Calendars, Banners and DropFiles and Galleries. 

When you work in these areas of the site, each will have its own category creation 
option, but they are all very similar in how they work. 



 

24 

Sometimes it is useful to have categories within categories or sub-categories. This 
sub-category idea leads us to consider the 'Parent' & 'Child' category hierarchy. For 
example, here is a way you might categorise content about birds and plants. 

1. Create two Parent Categories called "Animals" and "Plants".  
2. Create two Child Categories called "Birds" and "Mammals" and put these in 

the "Animals" category.  
3. Create two Child Categories called "Trees" and "Flowers" and put these 

under the "Plants" category.  

So, the arrangement of these categories would be: 

• Animals  
o Birds  
o Mammals  

• Plants  
o Trees  
o Flowers  

You certainly don't have to use sub-categories but in some cases it’s 
useful. 

 

No matter where you work within the website control panel, creating content 
categories is pretty much ubiquitous! Most of the pages you see just wouldn't work 
without them, so even if you only create one or two categories to hold everything 
(and that's quite common), you still need to understand they are important. 

4.3 Creating and Assigning Categories 

When you create categories and assign content (articles, links, contacts) to 
categories, you should ideally have a pre-planned structure in mind. 

Think how you might set up folders in a filing cabinet; first you create empty folders 
and label them in a practical way and then over time you create items and put them 
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in the most appropriate folder. This way, you can organise your items in a more 
sensible way so you can access them more efficiently. 

4.4 Default Categories 

You might see the Uncategorised category is already defined by default in your 
website. The Uncategorised category is used for articles that really don’t fit in any 
other category. It’s most used for small sites with only five or six articles; with so few 
articles, you wouldn’t really need to divide them into categories. 

Larger sites (maybe yours) will have other categories already established and the 
Uncategorised item already removed - no problem if that is the case. 
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5. Publishing 
One of the most useful features of your website is called Publishing. This feature is 
your way of switching on and switching off different items on your website so that 
they are no longer visible to the public. For example, if you no longer wish the public 
to see a particular webpage in your website then you can set the publishing state (for 
the menu item that reaches the page) to Off or No.  

Having unpublished the menu item, then the item in question will be hidden in the 
menu structure so that visitors can no longer reach the page that you wish to hide. 

Likewise, you can hide documents, calendar events, and blog pages. 

The method of setting an item to be published or not can be done manually by simply 
clicking buttons associated with the item you wish to switch off.  

The publishing options for the chosen area you are working in will be detailed in the 
sections of this guide.  

5.1 Automatic Publishing 

There are smart features however which can be very helpful when managing items in 
a more automatic way. 

5.1.1 Scheduled publishing 

You can set timers against almost all items which support publishing so that if you 
wish a particular item to automatically switch itself off on a defined day and time in 
the future, then this is possible. This feature is particularly helpful when managing 
documents such as letters home or vacancy documents which have some element of 
time related to their visibility on the website. By setting a Unpublish or Finish 
Publishing value into the future you can ensure that your web pages only display the 
most up-to-date and accurate information rather than old and stale content. 

Where publishing is related to aspects within this user guide, we will refer as 
appropriate. 
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6. Introducing Web Pages (Articles) 
The great majority of pages you see across your website are straightforward pages of 
text, sometimes supported by images, the occasional table and so on. These ‘pages’ 
are properly referred to as “Articles” and they are always found within the “Content” 
section of your Control Panel. Articles can be linked to from the menu (tab) system, 
or you can create hyper-links to other articles from within the article content itself. 

For ease of using common language though we can use Webpage and Article 
interchangeably throughout these help pages unless otherwise stated! 

Editing articles is almost the same as creating new ones, but with some key things 
you will need to bear in mind, so we will cover off editing articles separately. 

6.1 Getting Started with WebPages 

We will assume you are logged in to the /administrator Control Panel (CP) area of 
your website. To edit the vast majority of your webpages you will use the Content > 
Articles section of the CP. 

6.1.1 In Joomla 3 

Once logged in, use the top navigation bar to choose Content > Articles. 

 

 

 



 

28 

This will provide you with a list of all existing web page articles on your website: 

 

 

6.1.2 In Joomla 4+ 

In Joomla 4 onwards your access to Articles is simplified. Click on Content in the 
control panel side bar: 

 

 

Then click on Articles to view a list of all articles in your site. 
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6.2 Adding new Webpages 

6.2.1 In Joomla 3 

Once in the Article Manager (Content > Articles), you can create a new article. This is 
possible by clicking the Contents> Articles > Add New Article menu item or clicking 
the Contents → Articles menu item to open the Articles Page. Then click the New 
toolbar button. Below is the Joomla 3 View. 

 

 

6.2.2 In Joomla 4+ 

In Joomla 4 onwards your access to Articles is simplified. Click on Content in the 
control panel side bar: 
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Click the (+) icon to create a new article. 

6.2.3 The New Article Screen 

In both Joomla 3 and 4, the New Article screens are almost identical. 
Where there are significant differences, they will be described to avoid 
confusion. 

 

The New Article screen contains options for titling and categorising the article, 
editing its content, and selecting other useful parameters. 

6.2.4 Key Top Fields 

 

Title: You must enter a title in the Title field. This is used when the article title is 
displayed on the webpage. 

Alias: The Alias field is important for the Search Engine Friendly Address features. If 
you do not enter anything, the system will generate it for you so it's best to leave this 
empty. 

6.3 The Editor Panel 

The editor panel shows several tabs across the top. The most frequently used tabs 
are Content, Images and Links and Publishing. If there tabs that you don’t see on your 
site, you may ignore them. 
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6.3.1 The Content Tab 

The Content tab holds the space where you add, edit, and remove text content (and 
other media as needed), to the article. The editor behaves a little like MS Word and 
you are provided with a toolbar or ribbon that holds several icons to allow you to 
work and style with your content.  

Simply type your content into the editor panel. You can also paste content here from 
an external source such as MS Word but there are tricks and hints you will need to 
follow to be sure the text appears correctly on the website.  

See our section later "Pasting Article Content". (Section 6.10) 

6.3.2 The Editor Toolbar 

The website editor which you see and use when editing an article offers a variety of 
styling features which allow you to change the look and feel of the text in a page so 
that it is more like a Microsoft Word appearance. Using these styling options can 
ensure consistency in terms of font face, colour, size etc.  

 

Please note that using these features will not give you an exact 1:1 
look and feel - that's pretty much impossible given the real complexity 
that Microsoft Word offers as an advanced word processing system. 
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The above view of the editor toolbar shows the normally available choices that you 
can use when styling the content in your article. Note that each installation of a 
website may show slightly different icons in the toolbar. 

Buttons in the toolbar have 3 states - Enabled, Disabled and Active. 

Most buttons are Enabled by default appearing fully opaque. An enabled button can 
be clicked to execute its command or open an associated dialog box. 

A Disabled button will not respond if clicked and appears as a semi-transparent 
version of the button. A button is disabled when the current action or cursor position 

is not relevant for that button, for example the Delete Table button  will be 

disabled  when no table is selected or the cursor is not within a table. The same 
button will be enabled when the cursor is within a table. 

An Active button indicates that the current selection in the editor content can be 
edited by the button’s function. For example when an existing link is selected the Link 

button  becomes active . 

When the button is clicked and the Link dialog box is opened, the properties of the 
selected link are shown in the relevant dialog fields such as URL or Title. 

 

Once you have text in your article, you're now able to use the toolbar to select text 
and apply pre-set styles to it. Let's have a look at some of these now. 

6.4 Editing Basics 

6.4.1 Selecting text and elements 
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Before any item can be formatted or styled in an article it must be selected. This can 
be a simple action like clicking on the item, for example an image, or a double-click to 
select a whole word in a sentence. 

6.4.2 Selecting Text 

Text can be selected either by clicking and dragging to select a block of text, or 
by double-clicking on a specific word to select just that word. Once the text is 
selected it can be styled and formatted using the buttons in the editor toolbar. 

6.4.3 Selecting an element 

To select any element, such as an image or a table, click once on the element. Any 
button associated with that element, like the Insert / Edit Image or Insert Table 
button, will become active. The element can now be edited using the dialog opened 
by clicking the active button or styled by other buttons in the editor toolbar. 

6.4.4 Selecting Table elements 

Selecting a table, a table cell, or a table row can be done by first clicking into the 
table. Multiple table cells can be selected using the mouse, by clicking and dragging 
over the cells you want to select or holding the CTRL or SHIFT key and clicking in the 
cells to be selected. 

6.4.5 Standard styling features 

The standard styling features that you see on the top row of the toolbar will probably 
be familiar to you if you know Microsoft Word. These features are often used when 
we're editing text to make it look more appealing: 

6.4.6 Toolbar First Row 

 

6.4.7 Help 
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A quick route to getting help about using the editor system. Many users forget to 
click on this help icon and do not realise that when it is clicked, they will receive a 
significant number of help Pages in a pop-up window describing exactly how each of 
the features of the editor function can be used to make the webpage look better. 

6.4.8 Find  

If you need to find a word in a long article, this Find icon will help you. 

6.4.9 Undo and Redo 

Just like in Word, you can undo something you have 'done' using the editor panel and 
you can go backwards and forwards to redo. 

6.4.10 Text styling 

Just as in Word, you have the option to use Bold, Italics, Underline and Strikethrough. 
To use these, you would simply select the text in the editor, ensuring it is highlighted, 
and then click the appropriate button to enable that styling feature. 

6.4.11 Justification 

Again, as in Word, you can justify the text within the page so that it is fully justified, 
justified to the centre, left or right. 

6.4.12 Blockquotes 

This looks like a bold double quotes icon. 

• If you select some text inside the editor and then click on the Blockquote icon, 
then that text will appear in a particular way, styled to present a quotation on 
the website. This may present itself as being wrapped with large double quote 
marks or some other artefact. Often, within the editor this is simply shown as 
indented text but, when the page is viewed in the front end of the website, 
often a more interesting look and feel is visible. This option is used a lot for 
testimonials and quotations. If, when you set a sentence to be in Blockquote 
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style you see no change on the front of the website, let us know so we can 
help you. 

• To switch off the special styling, select the text in question and click the bold 
double quotes icon. 

6.4.13 Advanced Styling 

 

 

 

Adjacent to the Blockquote icon are two drop down choosers which normally have 
Paragraph or Format in the display. 

The first chooser is used frequently whereas the second chooser is rarely used but is 
provided for your website development team when applying specific look and feel to 
content on your behalf.  

Below we focus purely on the first drop-down which normally has the word 
Paragraph or Format on show. 
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When you click on the pulldown arrow to the right of the 
text on this first pulldown, you will see several different 
options which, when selected will apply that style to any 
selected text. Note that some sites have fewer choices to 
their pulldown! 

Some of our customers use many of the different choices 
however we often simplify these choices to make it more 
easy for you to choose the most suitable to your 
requirements. 

6.4.14 Using the Styling Chooser 

Let's imagine you want a heading within the article to make 
the text stand out from the rest of the text on the page, a 

little like the words "Using the Styling Chooser" above stand out (it's a heading too!) 

To accomplish this, you would select the text in question in the article editor and 
then use the styling pulldown to choose an appropriate style. 

Let's describe what these choices do in a little more detail: 

6.4.15 Paragraph 

MS Word Equivalent : Normal Font 

“Paragraph” this is the default choice of all basic text on the page. Essentially, it will 
apply a specific font, size and colour to the text which has been selected to be 
Paragraph style. In the editor screen, you may not see a great deal of difference 
between text which is Paragraph and text which is not Paragraph. You will however 
notice the difference when you look at the same information on the front of the 
website. This is because when the page is built at the time of viewing it, certain style 
rules are applied to information which has been wrapped with a Paragraph style. The 
difference may be subtle but it is nevertheless important. 
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6.4.16 Headings 

MS Word Equivalent: Heading 1, Heading 2 etc 

Heading 3 - this is a well-used style. Select text which sits on a line of its own, just as 
a heading would, and then choose the Heading 3 style to apply to that style to the 
chosen line of text. The result will be that the text will become larger, often bold and 
may under certain circumstances, be shown in a different colour. This is because 
when the page is built at the time of viewing, styling is applied to the information 
which is defined with a Heading 3 style. 

If Heading 1, 2, 3, 4, 5, 6 are accessible you can choose them but check your results in 
the front end to ensure they are what you expect. 

6.4.17 Blockquotes 

Blockquote - we saw above how this particular styling can be selected by clicking on 
the double quotes icon. This drop-down choice performs the same function. 

6.4.18 Spans 

Span - this style is used mainly by the development team when creating content on 
your page. We would largely not expect you to use the Span style as it has specific 
rules all its own! 

6.4.19 Toolbar Second Row 

 

As we have seen above, most of the text styling choices are available on the top row 
of the editor toolbar. The second row has additional features as follows. 

6.4.20 Cut/Copy/Paste/Paste as Text  

 The four icons allow you to cut text from the page, copy selected text and then if 
needed, simply Paste it, or Paste as Plain Text elsewhere. 
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6.4.21 Indentation  

Next you will see the ability to perform indentation to the left and to the right. This is 
very similar to how you might use Microsoft Word to move text in an indented way 
to the left or right. 

6.4.22 Numbered and Bullet Points Lists  

The next two icons represent the ability to have numbered and/or bullet point lists. 
Just like in Microsoft Word you can select paragraphs of text and apply these styles to 
them and the bullet points will automatically appear or, if you choose numbered lists, 
then the numbers will appear at the side of the paragraphs. At the same time, these 
numbered or unnumbered lists may be indented slightly. 

6.4.23 Sub and Superscript  

The next two icons allow you to have subscript or superscript text. From experience, 
these are rarely used. 

6.4.24 Case Change  

There is an icon which allows you to change the case of text. If you select a word or 
sentence, then you can use this icon and a drop-down will appear to choose what 
style of case presentation you wish to show. 

6.4.25 Symbol  

If you need to insert special characters such as Copyright (©), Degrees (°), and Euro 
(€), you can choose them from a range of characters from this button. 

6.4.26 Horizontal Rule  

Finally, on the second row, you'll find an icon which looks like a horizontal line. You 
can use this at any break between two paragraphs to insert a horizontal line to 
separate information. 
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6.4.27 Third Row Toolbar - Tables 

The third row of the toolbar is primarily associated with tables management. 

 

 

We cover Tables in detail on our Tables section. 

6.4.28 Fourth Row Toolbar 

 

The final row of the editor toolbar is related to how the editor looks, adding links, 
adding read more and page-breaks and finally inserting standalone images and 
random document links. The main icons to consider in day to day usage are: 

6.4.29 Add / Remove Hyperlinks 

A link to another website (hyperlink) may be inserted or removed in an Article using 
the Insert/edit link icons: 

 

 

Unlink/Link 

The Unlink icon removes any previously added hyperlinks when you click your cursor 
on such a hyperlink. No warning is given; if a link is applied to text, then the link will 
be removed. 

The Link icon allows you to add a hyperlink. See later for a section dedicated to 
working with hyperlinks in your article. 
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6.4.30 Add Images and Media 

 

These two icons allow you to upload an image or media file (audio or short video) 
that you can then insert into your article. See our section on adding images for more 
details. 

6.5 Adding Hyperlinks (Weblinks) 

Within a webpage article, you'll often need to add a link to a different page or 
another website by which we mean, the destination page could be somewhere on 
your own website or more commonly it could be a different website altogether. Such 
links are properly known as hyperlinks. 

Usually, you will create a hyperlink by choosing one or more words within the text of 
your article and then you will use that text as the basis for the link. 

Below is an example of some sample article text and we wish to use the word 
Governors (highlighted) as our link to reach a Governors’ page within our existing 
website. This is called an internal hyperlink. If you wanted to link to an external 
website, you would follow these instructions as well, but would have to apply one 
additional step. 

  

In the article editor, follow these steps: 

Select the whole of the word ‘Governors’ so that it is highlighted. 

Look in the editor toolbar (row 4) for the Insert/Edit Link Icon. It looks like this: 
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Click this icon and a Link pop window up appears: 

You can also select the text and use right-click > Insert Link to achieve 
the same results from a dropdown chooser. 

A popup window labelled “Link” appears: 

 

Now, consider whether your destination page is: 

a. somewhere within your existing website (Internal) or 
b. somewhere outside your website, such as Google or BBC (External) 

6.5.1 Internal Links 

If the link is inside your website, it will be a page that you will usually find by using 
the website’s front end menu or navigation. As such we can tell the link to use an 
existing Menu item as its URL or hyperlink address. To do this, click the black Menu 
folder to expand/open it to see the menus in your site. 

Look for the item labelled Main Menu or Top Menu. See our example below. 
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Now open the Main (or Top) Menu folder to see its menu items that you will 
recognised from your website. Now use the right scroll bar to move up and down the 

folders and open them until you find the menu item that you want people to see 
when clicking the “Governors” link in your article: 

 

 

Click the item (Governors / governors in our case) in the list box and its URL is 
inserted into the URL field: 
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This URL says ‘lindex.php?Itemid=569’ which is the website’s reference to our 
Governor’s page. 

Finally, click the Insert button: 

 

The popup will close and your text will now be shown as a hyperlink in the editor 
screen: 

 

6.5.2 External Links 

If the link is external to your existing website, such as Google, here is how you set the 
link to go to Google and to open it in a new browser page. Again, here is our Link pop 
up screen. 

 

 

Now, visit the external website and copy its full web address and paste the address 
into the Link URL field in the Link field above. 
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Towards the bottom of the pop-up window is a "Target" drop-down chooser: 

 

 

Click on this ‘Target’ chooser and select ‘Open in New Window’. This will prevent 
your website page being overwritten by the new page when the link is clicked. 

Click Insert 

Now, the pop up box will disappear and your link will be created to the external site. 

Save and Close your article and then test your link in your webpage article. 

6.5.3 Editing Existing Links 

When you need to edit a hyperlink in an article all you need to do is to click your 
mouse on the hyperlink in the article editor and then either use the Link icon in the 
toolbar or, if you prefer, use right click Insert Link. 

This will open the link editor panel and you can make the appropriate changes using 
the principles applied above. Once you have made your changes, click the Update 
button in the lower right corner of the pop up screen. The popup will then disappear 
and your link will have been updated. Click on Save & Close and to test your link on 
the front end of the website.  

6.5.4 Making links look like Buttons 

When you want a link to look like a button, it will need to appear on a line all on its 
own - in other words, you wouldn't create a button that sits inside a paragraph or 
sentence! 
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To create a button link, follow the guidelines above for creating the link and, before 
inserting or updating the link, click on the Advanced tab: 

 

 

 

Now, in the "Classes field, type the letters btn and hit the enter key to lock it in: 

 

Click Insert or Update 

Now, the pop-up box will disappear and your link will be created to the selected 
destination. 

Don't worry if the link does not look like a button in the editor - that is normal!  

The button appearance normally only shows when you look at the page in the front 
end. 
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Save and Close your article and then test your link in your webpage article. 

6.6 Using Read More 

Occasionally, when writing blogs, you may wish to limit the amount of text that is 
displayed to the website visitor so that the page does not look overly complicated 
with lots of information. This is where the Read More feature can be really handy. 

6.6.1 What is the Read More feature? 

This feature is provided to allow you to divide your text into an introductory 
paragraph and then "the rest". When viewed in the front end of the website, the 
website viewer would see only your introductory paragraph and a Read More button. 
Clicking this button will take the viewer to a page where the whole article can be 
viewed from top to bottom. 

6.6.2  How do you add the Read More feature to an article? 

This is very simple. When you're working on an article, underneath the article editor 
panel are a series of buttons, one of which is labelled Read More. 

 

To use this button place your cursor at the end of the first paragraph of your article 
and then simply click the Read More button. When you do this, the editor will display 
a Read More placeholder for you which will look like this: 

 

The remainder of your article text will sit underneath this placeholder. 

You can only add one Read More to an article. 
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Once you have saved your article, when you view it in the front-end of the website 
the Read More button will be displayed underneath the first paragraph, allowing 
website visitors to read the rest of the article in a full-page. 

If when you do the above, you find that on the front end of the website 
that the Read More feature doesn’t get displayed, contact us so that we 
can enable it for you on your website (on some websites, this feature is 
set as disabled by default). 

6.7 Tables on Pages 

Adding tables to articles is a very common requirement when you think about times 
that you want to show tabulated information such as lists of staff or governors 
information. You need to be a little careful though with tables and webpages because 
if you don't do it right, those tables can end up looking horrible! If your table has 
more than five or six columns, it is easy for it to end up looking like a Microsoft Excel 
spreadsheet and those don't behave very well at all on mobile phones! The rule of 
thumb which I like to stick to is that if your table has more than half a dozen columns, 
maybe it's best to have a document with a table inside it is a downloadable PDF. In 
this way, you can take use of the ability of Microsoft Word and all its features to 
make these tables look a little bit more attractive and, as downloads, there are not 
impacted by the issue that mobile phones experience when looking at a standard 
table on a webpage. 

6.7.1 Creating your Table 

The most common way to achieve this from scratch is to create the table using 
Microsoft Word and then copy the table and paste it into the article body on the 
website. This is quick and effective and in virtually all cases, a very reasonable layout 
can be achieved in almost no time at all. This section of the guide tells you all about 
what you can do with tables in that respect. 

6.7.2 Example of a table on a webpage 
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In the example below, we can see a very simple, two column table with a heading on 
the top and with striped effects for alternate rows. Above the table are some 
headings which define information about what is inside the table. 

 

 

The above table was created using Microsoft Word in a very straightforward way. To 
achieve it, no special styling was applied, in other words, it was a pretty basic looking 
table in black-and-white and took about 2 to 3 minutes to create.  

Note: Don't set the width of the table. Let it be the full width of your Word 
document page. 

This table could equally have been created using Microsoft Excel: 

 

Once you have the table created in Word or Excel, simply select all the table and copy 
it. 

6.7.3 Adding your table to your article 
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Now, go to your article and put your cursor where you would like your table to be 
displayed. Using standard keyboard functions CTL_V you can now paste the table 
which you copied from Microsoft Word or Excel directly into the article editor screen. 
When you do this, your editor screen will look a little bit like this - not very exciting 
but don't worry! 

 

 

 

At this stage, you're pretty much complete! Usually, the first row in your table will be 
shown as if it were heading when you look at it in the browser (front-end) and might 
have a different colour background and font size. If this doesn't happen and you'd 
like this to be applied to your website let us know and we can apply a couple of very 
simple changes to the site to make it happen automatically. 

Alternatively you can force the first row’s cells to be headers and we cover this 
below. 

6.7.4 Basic editing of your table 

Basic editing of the content in your table is pretty much the same as it would be in 
Microsoft Word. For example, you might want information in the table to be centre 
justified and all you need to do to achieve this is to select the appropriate data across 
the cells in question and then choose the appropriate justification option from the 
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editor toolbar. This is similar for information that you might like to be shown as bold 
or underlined or maybe even coloured. 

The same rules apply when you need to update your table with new information. For 
example, as new members of staff come and go you will need to update the table to 
reflect those changes. Editing the table is quite straightforward and obviously, if 
you're going to change the name of somebody in an existing row, simply edit it using 
the normal editing concepts of delete and replace.  

6.7.5 Adding or Removing Rows / Columns  

Working with rows and columns in your table is also quite straightforward and to do 
this we use the editor toolbar "tables" row, it looks a little bit like this with its twelve 
icons: 

 

Most of the icons in this toolbar will only be highlighted when you are actually 
within the table itself in the editor screen; if your cursor is not inside the table, the 
11 icons on the right in this row will be greyed out like this: 

 

From left to right, the twelve table icons have the following functions: 

1. Create a new table 
2. Delete the table that you are in ( place your cursor somewhere inside your 

table to do this) 
3. Set the properties for the role that you are currently on 
4. Set the properties for the cell (or cells) the are currently selected 
5. Add a row above the role where you are now 
6. Add a row below the road where you are now 
7. Remove the row where you are now 
8. Add a column to the left of where you are now 
9. Add a column to the right of way you are now 
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10. Remove the column you are in at the moment 
11. Split any merged cells back into the original number of cells 
12. Merge the cells you have selected into one cell 

So now, you can understand if you wish to add a new row, simply click your cursor 
into an existing row and decide whether you want to add a new row above it or 
below it.  

Then, use one of the add a row options (5 or 6 above) to create your new row, then, 
simply add your content to the row. 

Similarly you can do the same to add or remove columns. 

6.7.6 Formatting the content in your rows and cells 

Sometimes, when you add a new row, it might look as if there is no spacing above 
and below the text when you compare it to its neighbouring rows. This is due to the 
text added not being set as Paragraph style; its basic “Format” style. 

 

This is quite easy to fix. 

Click your cursor into a cell which looks like it needs more space around it and then, 
choose the Format > Paragraph chooser from the top row of the toolbar. This will 
make of the text in the cell have more padding around it: 

 

Perform this task for all cells which don't quite look right. Fortunately, when you 
bring the information in from Microsoft Word, it is automatically set as paragraph 
format and therefore you will not need to undertake this action 
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6.7.7 Setting a Header row or cell 

If you take a look at the image below, you'll notice the top row is a single cell (this is 
done by using the Merge Cells icon in the toolbar) and you'll also notice it has 
different styling applied to it – it has a dark green background and white bold text. 

 

This is done by setting the cell(s) in that top row to be header cells. 

To make this happen, click into the cell that you want to show as a header cell ( if you 
want all cells in one row to look the same, drag across to select all of those cells) 

Next, right click on the selected cell and choose "Cell" and then "Table Cell 
Properties", a pop-up will appear: 
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Look for the field with a label "Cell type" and note it is set for a value of Data or td. 

Click into this field and choose Header or th. 

 

Finally, click the Update button in the bottom right corner. 

Equally, if you want to have a row in the middle of the table or maybe even just one 
cell and you wanted to stand out like the top row does, do the same by selecting the 
cell(s) and applying the basics above. 

Now, when you save your article, and view the page in the front end of the website 
the cells you chose to be shown as header will have a different styling apply to them. 

6.7.8 Copying a Table 

If you need to copy a table within an article (to create a duplicate that you can then 
edit), all you have to do is click and drag across the entire table (above it to below it), 
just as you would in MS Word. This selects the table and its contents. 
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Then use CTL_C to copy the table. Next, put your cursor in 
the area of the article (or new/different article) where you 
want the duplicate to appear, hit the enter key to give a new 
line and then use CTL_V to paste the copied table into the 
article. 

Finally, edit the duplicate to suit the new content, Save & 
Close. 

6.8 The Article Editor Right Hand Column 

The right-hand column contains important options which 
dictate whether or not the article will be visible on the 
website, and by using the Category chooser, whereabouts on 

the website it will appear. the Featured option is also there for the same reason. 

6.8.1 Status 

Select the Status: Published to ensure the article is visible on the site, (you can also 
choose Unpublished, Archived, or Trashed) 

6.8.2 Category 

Select a Category using the drop down chooser. Remember, Categories are really 
important and choosing the right one can impact if your new page is seen in the 
correct area of the website. See the Categories section for more background on how 
these key tools work. 

6.8.3 Featured 

The Featured setting, can be set to indicate if this article should display on the home 
page. [Note that this setting is not used in all sites] 

The following choices can be left as default: 

• Access restriction: Public 
• Language: All 



 

55 

• Tags: Empty 

• Notes : Can be used if you wish but the notes are not visible on the website 
itself so they are sometimes useful for adding a comments or reminders about 
the article for future reference. 
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6.9 Other Article Editor Tabs 

The other tabs, Images and Links and Publishing in particular offer other useful 
options or parameters for the article. We cover these in separate help pages where 
they are relevant. 

Note that Options, Blog Media, Configure Edit Screen and Permissions are NOT used 
by us on our websites. 

 

6.10 Editing an existing Article 

We have already detailed how to add a new webpage article and here we describe 
how to edit an article that already exists. 

6.10.1 Searching for the article 

From the list of articles, search for and click the title of the article you need to edit. 

You can use the Search feature to find the article if it’s easier. Type in a word from 
the article title - you don’t have to type the whole title in - and click the magnifying 
glass icon to find the articles with your chosen text. 

 

 

When you see your article in the list, click its title to load it into editor mode and you 
will see your article text etc. in the editor panel. 

Help! I see a Padlock and can't edit the article!  See Section 6.17 - 
Troubleshooting! 

6.10.2 What if you have new content to replace an entire existing page? 
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Imagine you have completely new content for your page (rather than fixing a small 
section of the article). Maybe you might have the text in a Word document so here 
we will show you how to copy from Word and paste it into the editor. It’s pretty 
straightforward! 

First, select all of the text in the editor panel that is no longer relevant and of course, 
delete it.  

Then either type in your new text or copy and paste it from a Word document.  

Here’s how… 

6.10.3 Pasting Article Content 

Often you will want to create webpage content using Microsoft Word. You might do 
this in order to check for spellings, grammar or because it is simply easier that way to 
put your thoughts together. 

Regardless of the reason why you use Microsoft Word, rather than type directly into 
the article editor, this help guide will provide you with support to ensure that the 
final result looks smart and consistent, in line with the rest of the content of your 
website. 

Caveats 

A website is not a word processor! Microsoft Word is outstanding when 
it comes to word processing; it allows you to choose different fonts, sizes 
etc. and assign those styles to different parts of text in your document. 
In this respect, if all you need to do is to print out such a document then 
Microsoft Word is clearly an application of choice. Sadly, websites were 
not designed to handle the very sophisticated styling which Microsoft 
can apply to a printed document.  

Secondly, although technology has advanced considerably since website 
systems were first created, there are still pitfalls which can confuse 
website editors when they use Microsoft Word as their source for 
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website page content. The main reason for this dilemma is that 
Microsoft wraps its text with Microsoft formatting instructions. This is 
fantastic when you need to copy and paste between different Microsoft 
documents but, when you paste the same information into a website 
page, the website has no idea how to deal with the Microsoft formatting 
and ultimately, given the rules it has to play with, will do its best to 
render the page. It frequently looks a mess though! 

6.10.4 How to Copy/Paste correctly 

Whether you need to copy a single paragraph or three or four pages of content from 
a Microsoft Word document, you can paste the information into either a new 
webpage article or within the body of an existing webpage article. The steps below 
will give you the outline which, if followed correctly, will lead to success every time. 

6.10.5 Using the website formatting facilities 

Let's imagine that you have copied some content from a Microsoft Word document 
which uses bold, underlining, headings and other styling. These look fantastic on the 
Word document and you would like to emulate that on the website. 

First of all, follow these steps: 

1. Create an article or edit an article where you wish to paste this text. 
2. In the editor panel, use Control_V to paste the content into the panel 
3. The text you have pasted will then be shown in the article with all the 

formatting that Microsoft applied 
4. The next stage is to remove Microsoft formatting to make the page look more 

appealing. 

6.10.6 Removing MS Formatting 

Even if the content you see in the editor looks ok, its wise to remove any traces of MS 
formatting. To do this: 

Select all of the pasted text in the editor 
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Click on the 'Remove Formatting' icon on the tool bar. This icon looks like a red 
tipped eraser and is usually on the top row of the toolbar: 

 

Once clicked, the selected text will have any spurious MS formatting removed. You 
might not see much difference in the editor screen, but the changes will be seen in 
the front end of the site when you visit the page. 

6.10.7 What if CTL_V to paste doesn't work as planned? 

If CTL_V does not paste the content into the article, use the icons shown and click on 
the “Paste as Plain Text” icon to see a pop-up window into which you are prompted 
to paste the text previously copied, using the CTRL_V keyboard shortcut (or for Mac, 
CMD_V). You might also be able to use the right click mouse action for this. 

 

 

 

The copied text is inserted into the pop-up window. 
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You will see that any of the styling from the Microsoft source document is stripped 
out entirely (colour, font types, font sizes etc.) 

Next, click on the blue Insert button at the bottom of the pop-up window. 

This will close the pop-up window and the text that you added to it will be inserted at 
the insertion point where your cursor was within the article. 

6.10.8 Sorting out pasted paragraphs 

When you have pasted / inserted the content into the article editor area you might 
need to check through the content and simply tidy up the layout. For example, when 
content is added from MS Word, the paragraph breaks which Word uses are often 
replaced by web friendly "line breaks". On a webpage, these look very similar to 
paragraph breaks but they are not exactly the same and the appearance is often 
different. The difference is that the spacing between paragraphs is incorrect. 

The spacing between the paragraphs is not showing because the conversion from 
Word to Web has removed the paragraph markers. To fix this in the article editor, 
simply place your cursor at the beginning of each new paragraph and press the enter 
key. 

Ripple through the rest of the pasted content, putting your cursor at the beginning or 
end of each paragraph, and press the enter key to separate it from the paragraph 
above. This should only take a moment or two to achieve unless you have pasted a 
massive amount of text! 

6.10.9 Adding Section Headings 

The final stage of tidying up the content is to apply styling to main headings. 

Perhaps, in our source Word content, headings were added to stand out from the 
rest of the body text in the page. In Word, this is done using a Microsoft heading 
style: 
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Similarly, in web technology, we have a series of predefined heading styles that can 
be applied to a block of text. Look at the toolbar at the top of the editor panel where 
you will see the drop-down style choosers: 

 

 

The first (left) usually displays he word Paragraph but, it may show Format.  

The second (right) will almost always show Styles – ignore it! 

In order to change the text in our article so it looks like a heading, simply click your 
cursor on to the line where the heading needs to be displayed and then click the 
Paragraph drop-down to choose (for example) Heading 3: 
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We use Heading 3 most often because it is pre-set with a specific size, font and 
occasionally colour which is consistent across your website. When you have made 
this change, you'll notice that the text changes to reflect that you have selected it to 
be formatted in style Heading 3. 

Note: You may well see fewer or more choices in the style chooser. Don’t 
worry – we often remove rarely used options! 

 

In the editor the heading style might now be bold, larger font and/or, depending 
upon your own particular website settings, maybe a different style font altogether 
and maybe a different colour. It might look nothing like you expect but fear not, it 
will look fine on the front-end. 

6.10.10 Saving your Changes 

Once you have completed your article changes, you will use the buttons at the top of 
the page to commit your changes to the database and make them live on the 
website. Or not! 

Please refer to the top series of buttons in the Article page 

 

6.11 Article Action Buttons 

Please refer to the top series of buttons in the Article page 

6.11.1 Joomla 3 Buttons 

 

6.11.2 Joomla 4 Buttons 
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In Joomla 4, the developers minimised the number of buttons by providing a drop 
down option on the Save & Close button for Save & New and for Save as Copy. In 
general we only use the button itself and the drop down choice are only used for odd 
occasions. 

6.11.3 Save Button 

Click the Save button to save your changes but remain on the Article edit screen to 
make further changes. 

When you perform a Save of any form, a green message will indicate that the article 
has been successfully saved. 

 

If you have not completed something such as the Article Title or Category fields, a red 
error message such as that shown below will appear indicating the missing 
information. 

 

6.11.4 Save & Close Button 

Click the Save & Close button to save your changes and return to the Article Manager 
screen. 

6.11.5 Close Button 
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When you click the Close button, regardless of changes made, any unsaved work is 
lost and the article editor will close. 

6.11.6 Versions Button 

The Versions button is very useful! As you make changes to your article and save 
them, the database stores your versions so if you need to, you can revert to previous 
article versions. Let’s put this into context.  

 

Inside the versions pop up box, you will see a list of dates you saved the article. To 
view how the article was on that a previous date, simply click on the date and 
information will open in a new window. 

As you scroll down the panel you will notice that it doesn’t only display the main 
content of the article, it stores literally everything about it. 

6.11.7 Restoring an Article to a Previous Version 

Once you have found the version of the article you wish to revert back to, simply click 
the checkbox next to the date and click the “Restore” button. 

Your page will reload back to how it was on your selected date. 

To apply these changes, click “Save & Close”. 

6.11.8 Comparing Versions of an Article 

A great feature of content versioning is that if you want to compare two versions 
against each other you don’t have to manually restore the dates and look for the 
differences by eye. 
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You simply select the checkbox of whatever two dates you want to compare and then 
click on the “Compare” button. 

This will open a new window that shows the full content of both versions along with 
the differences between the two highlighted for ease of viewing. 

 

6.11.9 How To Prevent an Article Version being Deleted 

Once you have exceeded your “Maximum Versions” limit (set at 10 in the system 
configuration), Joomla will remove the oldest version to make space for the newest 
one. 

If you want to ensure a chosen version doesn’t get deleted, all you need to do is click 
the “Keep On/Off” button on the date you want to keep – it should now say “Yes” in 
the Keep Forever column. 

 

You can remove the Yes state easily by clicking the padlock. This will revert the Keep 
state to No. 
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6.11.10 Making a Note about the Version 

Another useful of the feature of Content Versioning is the ability to add a Version 
Note. This allows you to write a short reminder or note about the article for 
reference. 

This is done before you save the article, outside of the versions pop up box; and it is 
located in the article’s editor sidebar (to the right of the main content). You will see 
an input box entitled “Version Note”. 

 

The Version Note can be very useful as it is visible inside the versions pop up box. So, 
taking a few seconds out when you make your next update could save you hours later 
on down the line. 

6.11.11 Deleting old Versions 

Lastly, if you want to delete an article version, this can be done through the Versions 
popup screen also. Click the checkbox of the date you wish to delete and click the 
“Delete” button. 

This may be useful if you are trying to save some space but I would avoid being too 
gung-ho with this feature because once it’s gone, it’s gone! 

6.11.12 Preview Button 

When you create an article (or edit it), you might like to see what its like without 
having to go to the front end of the site to see what its like. This button will provide a 
pretty close reflection of what the page (including sidebars etc) looks like. 

6.11.13 Accessibility Check 
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If being ultra compliant is your thing in terms of accessibility of your web pages being 
absolutely perfect for online readers and those with disabilities, the Accessibility 
Check will help you. When clicked, a preview of the page will be displayed and in the 
lower right corner you will see an icon for accessibility (human shape outline) with 
information about what the checker has discovered. See example below: 

 

 

When you click on a red triangle that is reporting an error, it will reveal the reason 
and what to do to fix it: 
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I this instance it is recommending that the words Login Screen should be set to 
Heading 2 style and not Heading 3, because the page title is Heading 1. 

You can close the checker and edit the errors and recheck until (all being well) you 
have no errors: 

 

6.12 Articles as Blog Posts 

6.12.1 Firstly, what is a blog post? 

Like a diary, you would write a blog post to relate about what's been happening 
perhaps in your school or class over recent days or weeks. You might also make 
reference to future activities to give the website reader something to look forward 
to. Like with a diary, ideally you will keep the blog posts quite regular so that the 
website visitor has something new and interesting to read whenever they visit. 

We often set up blogs on school sites so if this is of interest to you, get in touch so we 
can set the system up to support your blogs. 

6.12.2 What does a good blog post look like? 

A good blog post should contain a healthy size paragraph of information which is 
both informative, entertaining and realistic.  

The information provided in this paragraph (and it can be more than one paragraph) 
should ideally be related to the curriculum so that website visitors can understand 
exactly what has been going on in a particular year group or classroom.  
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In addition, though not mandatory, it sometimes helpful to support the text with 
some complementary photographs in the form of a small gallery.  

Together, the gallery and the text form an engaging page for the website visitor. 

6.12.3 What does a blog post not look like? 

Well, often people think that a blog post is nothing more than a series of 
photographs taken to record activities in school or class. But this is seen as a poor 
way to use blogging because without contextual information the images do not fully 
convey what's been happening. 

6.12.4 How does a blog work? 

With respect to your website, a blog is simply a list of articles which belong to the 
same category and are displayed on a page in a format that gathers those articles 
together and shows them with the most recent article at the top of the page.  

So, in order to create a blog post you need to add one additional step to your normal 
article creation process. This additional step is important in that it tells the website 
which blog page your post will be seen on. This is done by choosing the correct 
Category when you create your blog post through the article manager. 

6.12.5 What categories might exist? 

All schools are different and therefore it's difficult to explicitly declare the number 
and names of categories which might already exist when you look on your website. 
However, in order to try to be consistent, when we support you in creating your blog 
categories we generally name them such as "Reception Blog" or "Sports Blog".  

By choosing the appropriate category when you create your article will allow the 
website to display your article on the appropriate blog page. 

Note, if you fail to choose the correct category when you create your 
article or, if you choose the wrong category, then your post will not 
appear where you expect it to! 
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6.13 Creating a New Blog 

The steps involved in creating a new blog on your website are: 

6.13.1 Create a blog Category 

You need to create a category for your blog to organize your blog content. To do this, 
go to Content > Categories and click on "New" to add a new category. The category 
can have any name you wish but sensibly you will give it a name that is related to 
your blog. If you need to create several blogs, for example one for each area of your 
school, then repeat this action So that you have one category for each area. 

6.13.2 Create a blog article 

As you will see later in 6.1.4 (Starting your first Blog Post), creating an article for a 
blog post is the same as creating or editing any article on your website. Go to Content 
> Articles and click on "New" to add a new article and assign it to the appropriate 
blog category such as the blog category you created earlier. 

6.13.3 Configure a Menu Item  

You we'll need a new menu item to reach your blog. Go to Menus > Main Menu > 
Add New Menu Item. Choose the menu item type "Category Blog" and configure it 
appropriately. We have a section dedicated to setting up menus elsewhere in this 
guide. 

When you have set up your menu correctly we will be able to use the website 
navigation to reach our new blog and you should see your article that you created for 
it on display. 

6.14 Starting your first Blog Post 

Let's use the following scenario; you are a class teacher looking after the Reception 
year group in your school and you have written a number of points down somewhere 
that will allow you to write a friendly and informative blog post which you will create 
to appear on your website reception class page. 
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6.14.1 Steps to create your first simple blog article 

1. Go to Content > Articles and choose the New button which you will see 
towards the top left of the web browser screen. When you do this, a new 
blank article will be presented to you.  

2. Type in an interesting and relevant title into the Title field at the top of the 
article editor. Keep it short and punchy. There is no need for war and peace in 
the title field! 

3. Next, click into the Editor panel and either type in your blog post information 
or, (sensibly) if you have created it in Microsoft Word so you can check for 
typing and syntax errors, copy the text from your word document and simply 
paste it (CTL_V) into the article editor panel. 

4. Over on the right hand side of the page you'll see a chooser labelled Category. 
Click on the chooser and select the category which reflects your particular 
area of blog responsibility. For example, for a Reception blog, you would 
probably choose the Reception Blog category! 

5. From the top of the page, click the Save button. 

Now, visit the website front-end and go to your blog page and you should see your 
blog article on display. 

6.14.2 More sophisticated ideas 

As mentioned earlier, it might be fun to add a single header image or a small Gallery 
to your blog post to show a handful of associated images. We cover adding images to 
Articles later in this guide. 

6.15 Publishing and Unpublishing an article 

NOTE Unpublishing an article can have unexpected results! There is only 
(in our experience) one reason to publish an article and that is when the 
article in question is an item as part of a blog.  

Remember, blogs are groups of articles which are all assigned to the 
same category and are displayed as a rolling list of articles on a 
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particular page of your website. There is no other reason to unpublish an 
article! 

6.15.1 Why Unpublish an Article? 

The only reason that you will need to unpublish an article is because you no longer 
wish to see that article on your website. As highlighted above, this is not something 
you would normally do on a day-to-day basis. 

However, this doesn’t apply to blog articles, this being because blog articles belong to 
a group (category) or articles. If you unpublish a blog article an error will not appear 
but if you unpublish ALL articles in a category, you will possibly see a message like 
“There are no articles to show in this category”.  

6.15.2 Unpublishing a blog article 

If you need to unpublish a blog article for any reason these are the steps you take: 

In Content > Articles, search for the article title in question, and in this case, let's 
assume that you wish to unpublish the blog item called Slideshows from PowerPoint: 

 

You will notice the green tick is displayed which represents the fact that this 
particular article is currently published. So, where ever the blog is displayed on your 
website for this particular category then this article will be displayed with its peers. 

To unpublish the item, click your mouse on the green tick to change it into a red 
cross. There is NO NEED to Save - it is saved for youl 

 

Now that you have done this, the item itself will no longer be displayed as part of the 
blog. 
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6.15.3 Results of publishing non-blog items 

If you unpublish an article which is not part of the blog then it's quite likely that when 
you try to visit that page on the website by using the menu which is set up to display 
the page then you will see a 404 Article not found error message. 

 

6.15.4 Why do I see a 404 Error message? 

This happens because your menu has been set up where certain menu choices link 
directly to certain articles.  

When you click on such a menu choice, the content management system performs as 
requested and tries to load the article that the menu is linked to. However, because 
you have unpublished that article, you receive an error message because the website 
cannot display an unpublished item! 

Maybe you no longer wanted to see the particular article at all on your website and 
you thought that if you unpublished it it would simply make the article go away but in 
reality what you have done is partly broken your website! 
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6.15.5 Fixing the 404 error message problem 

To overcome this issue, what you should do is to publish the article again and then 
remove the menu item which was used to find that article. We have a help page all 
about this which you will find in the section or Menu Management later in this guide. 

In a nutshell, if you follow the Menu Management section about unpublishing menu 
items, when you refresh your website ( probably best done by visiting the homepage 
first), you will notice that the menu item (which called up the article that you no 
longer wanted to see) has now been removed from the menus list. 

6.16 Searching for Articles in the Control Panel 

Sometimes, finding content across a website can be tricky. We know the site contains 
articles and modules and so on but we don't always enable the search function on 
websites for a variety of reasons. It doesn't matter what those reasons are right now, 
suffice to say that sometimes you may need to go looking for particular words across 
the whole website so that you can remove them or change them. Most of these 
words will be found in the articles that you have created for your website and one 
very quick way to go looking for particular words (or strings of words or numbers) is 
to use the Context Search facility within the Article Manager. 

6.16.1 Where will I find this? 

When you are in Article Manager ( via Content > Articles), you will always see the 
Search feature at the top of the page: 

 

In the search field, normally you would type in a word and when you click on the 
magnifying glass icon, any articles with that word in the title or in their alias will be 
displayed. Here we are searching for articles with school in their titles or aliases: 
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But what if you wanted to look for the word "documents" across all articles? Simply 
putting the word documents into the search field will probably generate few if any 
valid results. So, if you want to find which articles include the word documents, you 
should use a different technique when using the search field. This is where the 
context search comes into play. 

6.16.2  The Context Search facility 

To use the context search facility, you still use the search field but you use a format 
as shown: 

content:[yoursearchtext] 

Example: we are looking for the word school INSIDE all articles: 

 

 The results are ( in my example): 
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You will notice that the titles and aliases of the articles in the results list might not 
include the word school at all but we can be confident that if the articles are edited 
we will indeed, somewhere, find the word school so that we can edit or change that 
word 

6.17 Troubleshooting Articles 

Sometimes you will see an article which tells you that the item cannot be edited with 
an error telling you: 

“Check-out failed with the following error: The user checking out does not match the 
user who checked out the item. You are not permitted to use that link to directly 
access that page", or similar. 

These items will display a padlock icon next to the title to the affected item, like this: 
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6.17.1 What the padlock icon means 

Generally, when a user opens an article to edit it, the system locks the article in order 
to prevent other users from editing the same article at the same time.  

This functionality guarantees no-one can overwrite somebody else’s simultaneous 
edits. The padlock tells you someone else might be editing the item you want to work 
on. 

This can also happen (item can be locked) when someone gets timed out of an 
editing session or used the back button or simply closed the browser instead of the 
Save & Close or Close button. 

As such an item will remain locked if you don’t exit/close the item properly (see 
below for what this means) once you are finished editing. This is by far the most 
common cause for locked items. 

Fortunately this is a very easy problem to fix. 

6.17.2 How to unlock a locked item 
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First do not worry, because you are an administrator you can unlock all those items 
one by one or all of them in one go. 

If you want to unlock only one item, simply click on the padlock to unlock the item. 

If there are many locked items, select the items with the tick box next to each and 
click the Check In button from the Toolbar; this works with one or multiple items 
selected. 

 

6.17.3 Closing Article Edits Correctly 

What do we mean by ‘closing an item correctly’? 

When you finish editing the article, it’s your job to tell the website "I’m finished now, 
you can let someone else modify this item now if they need to!" 

If you don’t let the website know you’re done, it assumes you’re still actively 
modifying the article and blocks anyone else from editing it, even if you have 
disappeared for a coffee! 
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Here are a few common scenarios that leave an item unnecessarily locked even after 
editing is complete: 

• The editor simply closed the browser tab 

• The editor hit the back button on the browser 
• The editor went to a different tab without clicking ‘close’ 

• The editor went for a coffee break and the session timed out 

• The editor closed the browser altogether 

What are the proper ways to close an item? 

To tell the website that you’re finished editing and to allow others to edit an article, 
there are two correct ways to exit the article: 

• Click on the Save & Close button  
• Click on Save and then the Close button  

 

You can now click into the editor panel and change/add text as needed just like 
editing a Word page. 

Minor edits should only take seconds to complete and when done, simply click “Save 
and Close” on the top row of buttons. 

. 
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7. Working with Images/Photographs 
Uploading and adding images to complement your article text content is a way to 
make a page more interesting. Here we describe how to add images but there are 
some important things to consider first. 

7.1 The importance of image sizes 

7.1.1 What is a good size image for a website? 

Any image that is less than or around 1MB in size is ok, a general rule is "smaller is 
better". 

7.1.2 About BIG Pictures 

Using large images on websites can have several negative effects on the overall user 
experience and website performance. Here are some reasons why large images may 
not be healthy to use: 

Increased Page Load Time: 

Large images result in larger file sizes, leading to longer loading times for web pages. 
Slow-loading pages can frustrate users and negatively impact the overall user 
experience. With the increasing emphasis on mobile browsing, where network 
speeds can vary, optimizing page load times is crucial. 

Bandwidth Usage: 

Large images consume more bandwidth when users access your website. This can be 
a concern for users with limited data plans or slower internet connections, causing 
them to abandon your site if it takes too long to load. 

Server Load: 

Serving large images puts a strain on web servers as they need to transmit more data 
for each request. This can lead to increased server load and, in turn, affect the 
website's responsiveness. If a web page tries to load many large images, the sever 
can run out of resources and the page can crash! 
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Mobile Responsiveness: 

Mobile devices have smaller screens, and using large images that are not 
appropriately optimized for smaller displays can result in unnecessary data usage and 
may require more processing power, impacting the performance on mobile devices. 

User Experience: 

Users may have to wait for large images to load, leading to a poor user experience. 
Additionally, some users might not be able to view the images at all if their internet 
connection is too slow or if they are accessing the website on a device with limited 
capabilities. 

Search Engine Optimization (SEO): 

Search engines consider page load times as a ranking factor. Slow-loading pages, 
often caused by large images, may lead to lower search engine rankings, affecting the 
visibility of the website in search results. 

7.2 File Formats and Compression 

Choosing the right file format is crucial. For example, using uncompressed formats 
like BMP can result in significantly larger file sizes compared to compressed formats 
like JPEG or PNG or WEBP. Optimal compression techniques should be employed to 
reduce file sizes without sacrificing too much image quality. 

To mitigate these issues, we can help you with image optimization by describing the 
resizing of images appropriately, compressing them effectively, and using the right 
file formats.  

It is REALLY important to understand what the impact is of using un-optimised, large 
images in your web pages and galleries! Please… read on.  

7.3 Optimising Images 

So far we have helped you to understand why large images are bad for websites. 
When we talk about “optimising” images for the web, you can think about the results 
being that optimised images will (or should) 

1) look good 
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2) load quickly 
3) make images easy for search engines to index 

The remainder of this section will take you through the process of resizing 
(optimising) pictures for use on your website from start to finish, because adding 
images to a website needs a little preparation. 

There are a series of steps that we recommend which will make things work better 
for the website and for you. 

7.3.1 Ready the images ready for the website 

Best Practice : Its always best practice to optimise your photos etc. 
before you upload them to the site. Even though the website can resize 
your pictures for you when you upload them, doing this puts excess load 
in the website server that can either slow things down or (ultimately) fail 
the resize process altogether so, where possible we always recommend 
resizing the image prior to uploading them. 

To optimise a large image for the website, you’ll need to reduce its size (MB) and 
then upload the resulting smaller version to your website (more on that below).  

Starting with a large format is ideal, because you can always make a large image 
smaller; making a small image larger won’t work so well as it will pixelate and 
become grainy in appearance. 

That said, there are times when you WILL want to use large images on your website, 
such as for your home page slideshow. In these cases, if you use low-quality images 
and try to blow them up to be big enough, it will look fuzzy and horrible. We cover 
slide shows later in this guide. 

So how do you strike the right balance between size and quality? How do you even 
find the file size, image size, and resolution of your image? 
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7.3.2 Looking at your file 

You can find the file size and image size of your 
photos right on your computer. If you’re on a 
Windows machine, right-click on the image file.  

Choose “Properties” and the General tab will show 
you the file size in kB or MB. The “Details” tab is 
where you’ll see the pixel dimensions and the 
resolution in dpi. 

This example shows that the file is 1024x683 pixels 
in physical size. 

On a Mac right click on the image file and choose 
“Get Info.” 

In this instance, the file is 4288x2848 pixels in size. 
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7.3.3 Cheat Sheet for image size, file size, and resolution 

Application Size Notes 

Large images for slide shows or full-screen 
background images 

Max 1Mb 
Maximum width 1070px 

Most other small web graphics 300 KB or less 

Saving all images in Windows application If you have the option, always 
“Save for web” which will give 
your image a web-friendly 
resolution. 

7.4 Online Optimisation Tools 

Several online tools are available to assist you in optimizing large images without 
requiring advanced technical skills.  

Before using any of these tools, don’t forget to back up your original images to 
ensure that you can revert to them if needed. Additionally, always check the terms of 
service and usage policies of the chosen tool to ensure compliance with your specific 
requirements. 

7.4.1 Compressor.io 

Website: Compressor.io (RECOMMENDED) 

Compressor.io supports JPEG, PNG, GIF, and SVG file formats upto 10MB in size. It 
provides a straightforward interface for uploading images and offers different 
compression options to reduce file sizes. We always use the LOSSY option as it’s 
perfect for our purposes. 

 

https://compressor.io/
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7.4.2 PicResize 

Website: PicResize 

The PicResize website is nice because it not only allows you to resize images, it lets 
you do them in batches and does not expect you to install any software. So when you 
have several photos for a gallery you can use PicResize to resize them ALL for you in 
one go rather than having to resize them one at a time. You do not need to login to 
this website; it is open and free. We have used this website for a few years now and 
it is reliable and trustworthy. 

 

 

https://picresize.com/
http://www.picresize.com/
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The website is quite intuitive to use once you have uploaded all of your photos that 
you need to add to your gallery, the website will prompt you for resizing your picture: 

 

For the purposes of your website, we recommend choosing the Fit to Screen 1280 
Resolution option. 

Further down, where you can choose how to save the image (Save As), choose JPEG, 
better quality, and then click the blue " I'm done, resize my picture" button. 

 

You will then be presented with a final page where you can save your image to your 
local computer by clicking on the Save to Disk option: 
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Note that the image file size is reduced dramatically when you use this method. An 
uploaded image of that was originally 5.6 MB in size is reduced to a much more web 
friendly 287KB! 

 

 

The file(s) will be downloaded to your PC and you can then add them to a page or to 
a gallery! 

7.5 The different kinds of Image… 

There are four different types of image that you might want to add to an article, 
regardless of what kind of article it is. Let’s quickly look at your options: 

1. Article Header images 
2. Images that sit alongside your article text 
3. A Gallery of images that help the article story tell a better message 
4. A slideshow of images 

Each has its own purpose and understanding where to use them and what they look 
like will help you make your pages look more engaging. 
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7.6 Article Header Images 

7.6.1 Intro and Full Article Images 

Note: there are certain settings which configure the system to not show 
these images. If you set up Full or Intro Images but you cannot see them, 
let us know and we can enable them to be shown. 

7.6.2 What is an Intro Image? 

An Intro Image is an optional feature and gets its name because it is only displayed as 
part of a Blog or Featured Article Introduction. The introduction text itself is usually 
the first few lines of a blog post, used to entice web visitors to read more. A Read 
More button is usually used to then allow the visitor to read the Full Article. 

Is an Intro Image mandatory? No! You do not have to add an Intro 
Image at all if you don't want to! 

An Intro Image might look like these, taken from the Tapiochre Blog page: 
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So if you are writing a BLOG page, you might use the Intro Image to display a picture 
to help introduce the blog article. 

7.6.3 What is a Full Article Image? 

A full article image sits at the top of ANY article [not just blog or featured items]. 
Think of it as you might a magazine headline image. Is a Full Article Image 
mandatory? No! You do not have to add a Full Article Image at all if you don't want 
to! 

On a webpage, it will look like this: 
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In this example, there is an image at the top which takes up the full width of the 
block that contains the article text for that the page. 

7.6.4 Other Positions for the Intro and Full Article Images 

These images can be set to "float" or be aligned to the left, the top or the right of the 
article. For example, if you set the image to float or be aligned to the left, the article 
will look like this: 
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7.6.5 The Images and Links tab 

To set up Intro and Full Article images we use the Images and Links tab in the Article 
Editor. 

 

 

When you click the Images and Links tab, you will see a screen as shown below 
(Joomla 4 view but the principles remain the same): 
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Joomla 4 Images and Links 

 

Joomla 3 Images and Links 

The different sections are outlined below with a description of what each looks like 
and how it works. 

7.6.6 Intro and Full Article Image Settings 

You will note the settings for both Intro and Full Article Images - they look identical 
apart from the naming of the fields so we can use the same concept for both: 
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7.6.7 Intro Image and Full Article Image Fields 

To choose the image for these two fields as needed, click the associated Select 
button. 

Once you click the Select button, you can move to (or create) a relevant folder to find 
or upload and store an image. If the image is already uploaded, you can navigate to it 
in the folders available and select it to be displayed in the Intro or Full Article Image 
for the article. After you have selected an image, it will appear in the Intro Image 
field: 
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In Joomla 3, ,you can hover the mouse on the "Preview" 'Eye' icon to see a preview of 
the image. 

 

You can copy and paste the image link from the Intro to the Full Image field.  

This is a common practice and works well under most circumstances. 

7.6.8 The Image Float Field (or Image Class field) 

[This section is subject to review]. 

In Joomla 3, this pull-down chooser allows you to set the 'float' or alignment position 
of the image in the article. The term 'float' refers to whether the image floats to the 
left or right of the first paragraph in the article. Choosing 'None' tells the image to 
simply fill the full width above the article space. Note also that when you choose left 
or right, then the text will flow around the image. 

In Joomla 4, you can simply type “right” or “left” or “none”. 

The options are (click link to see examples further down this page). 

Right, Left, None. 

This tables below outline the options and outcomes. 

Image Float (Aka 
Image Class) 

Results 

Left Image will be found on the left of the article and text will 
flow round it 

https://itlookslikethis.co.uk/working-with-images/article-header-images-links#right
https://itlookslikethis.co.uk/working-with-images/article-header-images-links#left
https://itlookslikethis.co.uk/working-with-images/article-header-images-links#none
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Right Image will be shown on the right of the article and text will 
flow round it 

None Image will be shown on the top of the article and text will 
flow under it 

Other Fields 

FIELD LABEL USAGE AND PURPOSE 

Image Description 
(Alt Text) 

Gives the image some alternative text for Search Engines to 
understand what the image is and to support assistive web 
viewing 

No Description (Joomla 4 only). Does nothing! Do not use. 

Caption If you enter an optional caption for the image, depending on 
the settings of the website, the caption will appear under 
the image. Note: Not all templates display captions. 

7.6.9 Different views in Joomla 2 and Joomla 4 

When looking at the Images and Links tab in the two versions of Joomla you will see 
differences that are worth explaining. 

7.6.10 What do these choices look like when set up correctly? 

First, consider a sample page with no images but with text already added into the 
editor and saved. The sample is called 'My Lorem Ipsum Test Page": 
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7.6.11 Full Article Image (Float : None) 

To have a full width image at the top of an article, it needs to be wide enough. Below 
we see a nice wide image. Note though that it's not too tall as if it were, it would 
push the text of the article a lot further down the page making it less friendly! 
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7.6.12 Full Article Image (Float : Left) 

To have a left floated image at the top of an article, it needs to be smaller to not push 
the text too far to the right. Here we see a nice small image. 

 

7.6.13 Full Article Image (Float : Right) 

To have a right floated image at the top of an article, it needs to be small enough to 
not squeeze the text too far to the left. Here we see a nice small image. 
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So you can see that header images can be used to simplify the action of adding cool 
introductory photos to your blog posts and articles! 

7.7 Images in the body of the article 

Let's start by understanding what this means! So here is an example where we have 
text in a page (article) and we have added a single image to the article that sits to the 
left and the text flows round it gracefully. 

 

7.7.1 Insert a single Image 

If you need to upload a new image, place your cursor at the START of the paragraph 
where you want it to appear, and then click the "Insert / Edit Image" icon in the 
article editor toolbar: 
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Hint: the icon looks like a picture with a gold star on it: 

 

Bottom row of toolbar 

 

Image button 

This opens the "Image Manager Extended" window. 

 

 

With the Image Manager Extended you can 

• Upload images and resize and thumbnail them realtime, on upload 
• Create folders to save your images in a very structured and sensible way 
• Rename, cut, copy, paste and delete folders and images 

• Create and delete image thumbnails 
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• Edit Images in the Image Editor 

• Create Rollover images 
• Create Image Popups (requires JCE MediaBox or a compatible JCE Popup 

Extension) 

• Insert images into articles 

Look at this pop up screen and you will see three columns: 

Folders, Name, Details 

 

7.7.2 Choosing the best folder for your new image 

If you can, try to upload your new image into a suitably named folder. In this way, 
you can structure your images into suitably titled folders to help you find them again 
later if you need to. 

Look in the Folders column to see if there is a folder which has a title related to your 
school (but it might not, so don't worry – you can always make one!) 

If you find one, double click it to see what other folders are inside it, alongside any 
existing images which might have already been uploaded to that folder. 

7.7.3 Creating a new image folder 

If you cannot find a folder that’s been created for you already, you can create a new 
one.  

Look above the Details column are three icons: 

New Folder, Upload, Help 

 

 

Click on the New Folder icon to create a new folder for your images. When you do 
this, a New Folder panel will appear where you can label your new empty folder: 
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Type in a handy and memorable/meaningful name for your new folder, click Create 
and your new folder will appear in the middle column. You can now double-click to 
go into that folder to start uploading your images. 

7.7.4 Upload a file 

To upload a file into your selected folder, click the Upload button to open the Upload 
Dialog Panel 

 

Now, click the Browse button and locate the target file(s)on your computer (multiple 
files can be selected and added at the same time). 

Files can also be dragged and dropped into the upload dialog panel. 

The files will be added to the upload queue. The name of files can be edited (click 
their name in the queue to do so) and a file can be removed from the queue by 
clicking the trash icon. If you rename a file, avoid spaces, use underscores or hyphens 
instead. 



 

102 

 

Note a few ticked options below the queue list? We will cover those shortly. 

Now, click the Upload button to begin the upload. The progress of each upload will 
be displayed as a percentage and by the progress bar beneath each file. When all the 
files have been successfully uploaded, the dialog will close. If an upload fails, an error 
message will be displayed below the file name. 

When your uploads have completed, the upload panel will disappear and you will see 
your files have been placed into the folder you created and will be selected. 

 

7.7.5 The Image Options 

 

Under the queue list are two rows of sizing options. 
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Earlier we referred to large images… here you can make use of the website’s own 
internal resizer! 

7.7.6 Resize 

The Resize option is great is one or more of your images is large. For example, if you 
are uploading 3 images and one is large, you can check the tick box next to Resize and 
then set values to tell the resizer what to resize larger images down to. 

 

Above we have enabled resize for this upload and have configured the resizer to 
make any image that is greater in size than 1024 pixels wide to be exacly 1024px 
wide. The height will be scaled automatically to the correct size based on proportions 
of the source image so you don’t need to touch that field. 

There are two supplementary fields: 

• Crop to Fit 
• Suffix 

The Crop to fit option will look at the source image and crop it centrally to the size 
you set in the resize setting. Probably not ideal so we don’t use that option at all.  

The Suffix option is provided so, when you click Upload the resized file will be created 
with a suffix you define. In this way, your source image is uploaded and the resized 
file as well but with a suffix added to the filename. 

7.8 Adding an image you have already uploaded 

7.8.1 To Insert one Image 

Select the image you uploaded in the File Browser section by clicking on its filename 
in the Name column.  

When you do this, the file’s URL, its Alternate Text and Dimensions fields will be 
updated with the image properties. By default, the Alternate Text will be the 
filename. See an example below: 
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If you have to, you can adjust the properties (see below) as required then click the 
Insert button at the bottom of the dialog. 

 

If you now Save your article and visit your page, you will see the effect of your work. 

7.8.2 Making your image sit on the left or right of the page 

When you insert your image, you will notice that you have the Alignment field. This 
alignment field is used to push the image to the left, the right, or to sit in the middle 
of your page. When you do this, the text will then wrap around your image just as it 
would in a newspaper 
layout.

 

 

 

Experiment with this idea to see how your page looks when you choose different 
types of alignment. 

We usually apply handy hidden attributes to your added images when you set them 
to appear left and right such as padding space around them so you article text 
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doesn’t site exactly against your image (which looks bad!). These are automatic 
settings. 

7.8.3 Adding more than one image to an article 

Our approach here is twofold: 

1. Put images across the article as long as you have loads of text to support the 
images. 

2. Add a gallery to support short text content 

Adding a couple of images across a long web page is easy and you simply follow the 
guidelines above in “Add a Single Image” 

Read on for adding a gallery to your article. 

7.9 Adding Galleries 

Adding galleries of photographs or other images to your webpages is a great way to 
display multiple pictures which are shown as thumbnails. When you click a 
thumbnail, the full-sized image appears in a pop-up window. Adding galleries is quite 
easy and is often the simplest way to add images to articles. Below is an example: 

 

We use a component called Droppics (Components > Droppics) to help us add 
galleries of images to articles. We find that Droppics is easy to use but if you find that 
this option is not doing what you need, please contact us and we can soon fix it for 
your. 

7.9.1 How many pictures per gallery? 

Here’s a word of caution about the number of pictures in your gallery. 
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While galleries are super ways to display groups of images, if you add too many 
images to your gallery on any one particular page, you risk slowing down how quickly 
that page will load. Our experience tells us that if you have a gallery, it's best to have 
no more than 12 images in the gallery. 

7.9.2 Gallery Image Sizes 

Another word of caution about the actual size of the images that you add to your 
gallery! 

Another factor which will affect how quickly your page will load is not only how many 
images you have in your gallery but also the physical size in megabytes of each 
image. Earlier in the section on Optimising Images we talked about resizing and 
optimising images before you upload them to your site. With Galleries this is a key 
point so we ask you to do your best and ALWAYS OPTIMISE before adding images to a 
gallery.  

7.10 Droppics Galleries 

Dropics is a component that allows you to add photo galleries to your articles. 

7.10.1 Starting with Droppics  

You access the Droppics system by going via Components > Droppics. This will lead 
you to the ability to create new gallery folders and add images directly. You can also 
set up the way the galleries are displayed via this route. 

7.10.2 How to add a gallery to your webpage 

You need to be editing an article to do this! 

The basic principle of adding a gallery to your webpage (i.e. within an article) is to 
place your cursor where you would like your gallery to sit and then use the Images - 
Droppics button which sits underneath the editor screen to then create and insert 
your gallery. 
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Clicking this button causes the Droppics application to appear in a popup screen 
where you can choose or add a gallery to add to your article. 

 

 

As you will see above, gallery images are shown in folders; all you have to do is to 
select the folder you want to add to your webpage and click the blue Insert this 
gallery button which appears on the top of the right-hand column. 

Note that this blue button is not visible to you if you have accessed the 
Droppics system via the Component route!! 

7.10.3 Using the Droppics System 

Whether you access Droppics by going via the Components route or via the Article 
route, when you first open Droppics, you will notice it is split into three columns: 



 

108 

 

The first column is where you will see folders and each folder represents a set of 
images. The application calls these albums (which we think is a little bit confusing 
because otherwise we think they ought to be called galleries!).  

You can create as many albums as you wish and each should have a unique name so 
that you can quickly identify it amongst its peers. 

We use a standard naming plan for these album folders: 

MMYY-WEBNAME-ARTICLE 

Eg: 1223-YR6-HUNTING_FOR_SNARK 

Using this model for naming your folders helps you to know which year 
and month the folder is related to and also the part of the website where 
the folder of images would be found. This makes it easier in the future to 
delete old gallery folders! 
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The second column is where you'll see the images inside the selected album. You can 
add portrait or landscape images to this space by dragging and dropping them or by 
using the blue Select Files button.  

The third and final column is where you will choose how the album will be displayed 
as a gallery by selecting one of the six available themes. The default theme which 
looks like four squares is ideal for most purposes but sometimes if the images are a 
mixture of portrait and landscape oriented photographs, then the masonry layout 
will be more appropriate. We can help you choose the best one! 

This third column is also used to make choices about how each image appears, for 
example, you will regularly use this third column to define the caption for the chosen 
image. Other options are available here but are not used regularly so don't worry 
about them! 

7.10.4 Creating new albums 

New albums are created by clicking on the blue New Album button on the top left of 
the Droppics panel: 

 

When you do this, the system automatically creates a new folder for you at the top of 
the list and it will be labelled as "New gallery". 

7.10.5 Renaming the folder 

To rename a folder, hover your mouse over the folder name to see two small icons, 
one is a pen and the other is a trashcan. Click on the pen icon to see that you can 
now rename the folder to something more suitable for your use. Try to create 
original and unique folder names so that you can spot them later when you use 
them! See our plan above for a recommendation. 
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7.10.6 Deleting a folder 

To delete a folder and all its contents, hover your mouse over the folder and click the 
trashcan icon. You will see a warning notice asking you to confirm that you wish to 
delete the selected folder. Click okay to do so. 

7.10.7 Adding images to your gallery folder 

You can add images to your folder at any time either by clicking on the blue Select 
Files button or by dragging and dropping images into the dotted space, drop the 
image over the words "Drop images here to upload" to be sure! 

 

If when you drag-and-drop files into that dotted area you find that the files do not 
upload (i.e. nothing happens) then try again and drop the images directly over the 
words "Drop images here to upload". 

7.10.8 Uploading Large images 

If you upload large files (files that are greater than 2MB), you may experience a 
situation where the upload appears to ‘stall’ and the image upload will look a little 
like this: 
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Note the green tick. This means the file has been uploaded but the blue progress bar 
remains. This is the server’s way to show that the large file is being processed and 
resized to be more web friendly. If the progress bar never disappears, you will need 
to resize your images using online tools (see earlier our section about Optimising 
Images to help in this process before retying the upload. 

7.10.9 Putting images in a different order 

It is very easy to put images in a different sequence than the ones shown when you 
first upload them. For example, you may have a group of images of staff members 
and you want to show them in alphabetical order. When you upload them it's highly 
unlikely that they will be in alphabetical order and so you need a simple way of 
putting them in the right sequence. All you have to do is to select and drag and drop 
the imags into the right place. You can do this over and over again until all images are 
in the sequence you wish them to be shown in.  

7.10.10 Adding a Caption to an image 

Sometimes, but not always, you may need to add a caption to an image. An example 
of this is where you have images of staff members and you wish to put their names or 
titles underneath the image. To do this, select the image and the right-hand column 
will change to show the properties of the image. 

Then, scroll down the right-hand column to see the section for Caption: 
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Type in the words you want to show as the caption for the image and then tick the 
Show Caption tick box to enable the caption to be displayed. 

 Then, scroll down and click the blue Save Options button. 

Note: There is no feature for a description for your image therefore always try and 
keep the caption brief. If your caption is very long it will start to obscure the image 
when it is shown in the front of the website. 

7.10.11 Deleting an image 

To delete an image from a folder simply select the image in question and the right-
hand column will appear with the properties for the image. At the top of this column 
you will see a Delete Image button. Click this button to delete the image from the 
folder. 
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8. Working with Document Downloads 

Introduction 

One important aspect of any school website is the the ability to add, remove and 
change documents such as Policy files or Newsletters. This section will show you how 
to work with document downloads on your site. You will use the Dropfiles 
Component and will drag and drop (or select and browse to find) files for inclusion on 
the website. We will show you how to do this and also cover off some of the smart 
things you can do with downloadable files such as adding them to pages on the 
website.  

 

8.1 Getting Started 

Adding documents like policies, newsletters and vacanicies to your website is 
performed by using the DropFiles component via the/administrator control panel. 

8.1.1 Think Ahead - Word, PPT, Pub or PDF? 

Documents that we place on the website are usually PDF documents; this is because 
not all of your visitors have software like MS Word, Publisher or PowerPoint and so 
they will find it difficult/impossible to view those files format. In addition, viewing 
these non-PDF files on a mobile device often renders a pretty messy result! 

So, be sure you ‘Save As’ your file to be a PDF format filename. 
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8.1.2 File Names 

Next, name the PDF file in a neat and appropriate way – avoid non-alphanumeric 
characters at all costs, using hyphens or underscores is ok though.  

So, names like s02Safeguarding090119.PDF ought to be more suitably titled to 
Safeguarding Policy 2019.pdf 

There is a reason for this. When you see a downloadable file on the site, the file title 
you see (which is a hyperlink) is actually the filename of the file you upload to the 
system, so, when you upload the file, be sure the filename is exactly how you want to 
see it on the website. 

This means correct capitalisation, no awkward punctuation or words like 'for the 
website' etc. Consistent file names for Newsletters or Policies make for a more 
attractive website! 

You can upload individual or more than one file at a time, assuming all of the files will 
be added to the same group or category of files on the website at the same time. If 
you need to add different files to different categories, do each in groups. More on 
this later. 

8.1.3 Where to Start... 

Adding documents to the website is performed by using the DropFiles component via 
the/administrator control panel. 

 

Once you have logged in, navigate to Component > Dropfiles. 
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8.2 The DropFiles Component 

In this section and from hereon, we use the term "Category" and 
"Folder" interchangeably! 

When you navigate to Components > Dropfiles and you will see 3 columns of data – 
below is an example showing the categories in the left column which look like grey 
folders, files in the centre column and a properties or settings column on the right. 

 

If you see one, ignore the Google Drive Icon! 

Below the New button, you may see a triangle icon which represents connection to a 
Google Drive. This is a legacy button and is no longer used so you should not click it! 
If you do click this button then the new folder will be created but the results may be 
unpredictable! 
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8.2.1 Help! I only see TWO columns! 

If you cannot see the third "Settings" column, look for this <--- arrow icon on the top 
of the page on the right (see image below). This is the 'Expand" icon and allows you 
to view or hide the third column when using smaller screens. When you click it, it will 
force the third column to appear. 

Likewise, you can click it when it looks like this --->, in order to hide the third column. 

 

8.2.2 What are Settings? 

Settings are details related to the selected item. For example, when you select a 
category / folder in the first column, then the files in with the selected category are 
displayed in the second column. At the same time, the settings for the selected 
category / folder are shown in the third column. 

Similarly, when you select a file in the second column, then the settings for the 
selected file are displayed in the third column. 

8.2.3 Dropfiles Categories/Folders 

Dropfiles, like so many other areas of the website, uses categories to group files 
together and to make management of these files are easier. 

As we related earlier in the Categories section of this guide, categories are like 
folders. In Dropfiles you add related files to folders just like you would in the 
hardcopy world with manilla folders etc., so they are organised in a way that is simple 
to manage. 

8.2.4 Adding and Moving Category Folders 
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In order to create a new category folder, click on New Category at the top of the left 
column: 

 

 

Note: As mentioned above, if you see a triangle icon under "New", ignore and do not 
use it. This is a legacy feature for linking to Google Drive that we no longer support. 

A new category will be created at the bottom of the list. 

 

 

8.2.5 Renaming the new Folder 

This is important! 

If you do not rename your new folder, over time you will end up with a 
list of folders all with the same title of "New Category" and you will not 
know which one is which!  

To rename your new category, move your mouse over the newly created folder and 
click the Edit icon (a pen) which appears to edit the name. 

 

 

8.2.6 Deleting a Folder 



 

119 

You can use the Trash icon to delete the category and all of its contents.  

Move your mouse over the folder that you want to delete and click the Trash Can 
icon. You will receive a warning asking you to confirm that you want to delete the 
folder.  

Warning! When you trash a folder, it and its contents cannot be retrieved! 

8.2.7 Ordering the Categories 

To order/sort the categories to make them easier to find (maybe to want to have 
folders sorted alphabetically or need a specific order for your own purposes) you can 
use hover your mouse over the folder you wish to move (the cursor will become a 
cross-hairs) then click and drag and drop the folder icon to move it vertically up and 
down to where you want it to sit in the list of folders. Move it from up or down to put 
it in the right place. 

 

8.2.8 Sub-folders (or folders within folders) 

If you want the selected folder to sit within another existing folder, drag it first under 
the 'parent' folder it will belong to and then drag it from left to right slightly to make 
it a child folder of the parent.  
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Note, when a folder lives within another folder, a chevron (>) icon appears next to 
the parent folder. You can open or close the parent folders to see the child folders it 
contains by clicking on the > and v buttons on the side of the parent folder. 

8.2.9 Setting the folder up correctly 

When you create a new category/folder, you must select it in the left column, (even if 
it holds no files yet), and then look on the right side of the screen in the settings 
column where you will see the properties for the selected folder and the first area 
you will see is the Theme chooser and appearance attributes for the selected 
category. Unless otherwise instructed always choose the Simplex theme. If the 
Simplex theme is not available, choose the Table theme instead. 
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The Simplex theme is a newer theme built for selected websites that display your 
files as follows: 

 

The Table theme with its three columns is the default ‘older; layout for your 
documents - it will look a little like this when shown on the webpage: 
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With the theme selected you will see options under this area. You do not need to 
adjust any of these settings because we have set them for you already. These 
changes we have applied reduce the clutter that might otherwise be shown, for 
example display/hide file size, file hits number and so on. 

Once you’re done with changing the category Theme parameter, you should click on 
the Save Settings button at the top or bottom of the right column to save the theme 
preference for your selected category. 

8.2.10 Pagination of Files 

In the front end of your site, when you view files, there may be occasions when you 
have lots of files in a folder making the web page very long (to show them all at 
once). 

If you need to show files in groups at a time, we can enable ‘Pagination’ for you 
which will set the number of files shown ‘per page’ to 10, 20,50 or 100. Call us if you 
would like this feature enabled for your site.  

8.3 Adding Files to Folders 

With your categories in place (and you can add new categories at any time that you 
need them, you can now add files to any category (folder). To do this, first click a 
chosen Category Folder in the left column to select it. Obviously, the category you 
choose will be related to an area of the website that will display your files. 

Be sure you choose the correct folder - sometimes subfolders may hold the existing 
content you also wish to see! 
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8.3.1 Adding files to Subfolders 

If you see a folder with a chevron to the left, it means it has sub folders within it: 

 

 

Click the chevron to expand / open that folder to show its child folders. 

8.3.2 Adding (uploading) your file(s) 

You can drag and drop your files or you can use the Select Files button to choose files 
to upload – whichever suits your way of working is fine! 

8.3.3 Using Drag and Drop Method 

You may Drag and drop your file(s) anywhere in the existing list of files for the 
selected folder. When you use the Drag and Drop method to add files, then the page 
shows a blue overlay reading "Drop file here to upload". Simply do that. Don't forget 
you can add multiple documents at once to the same folder when you drag and drop 
into a folder. 
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When you drop the files, a horizontal progress bar will quickly show you the status of 
your file addition and when complete, your file(s) will then be shown in the list. 

8.3.4 Using Select Files method 

Click the ‘Select Files’ button to navigate your PC or school network to the files you 
want to add, choose them and click OK to add them to the selected Category. 

 

When added, just as for drag and drop, a horizontal progress bar will quickly show 
you the status of your file addition and when complete, your file(s) will then be 
shown in the list. 

With the file(s) now added to your DropFiles Category, the new files will show 
wherever the website is configured to show them. 

Note that new folders will NOT display automatically anywhere on your website! You 
have to tell the web where to display them. See later for Adding and Changing Files 
inside Articles. 

8.4 Moving, Deleting & Cloning Files 
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8.4.1 Selecting files 

When you have lots of files in a folder and want to choose more than one, you can 
use the CTRL key to choose multiple files at once. Keep the CTRL key down while 
clicking your target files.  

If you want to select a GROUP of files (for example the bottom 20 files), you can click 
the first in the group and, holding SHIFT, you can select the last in the group. All in 
the group will now be selected. 

8.4.2 Simple Tools 

When you select any file in a folder, above the centre panel you will now see a set of 
options: 

 

Let's run through these so you understand what they do and when you 
can/should/should not use them. 

8.4.3 Copy and Paste Icons 

You might think it's a nice idea to be able to copy a file and paste a copy into another 
folder. We don't recommend it! 

Using the Copy and Paste features at all is a bad idea and this is because doing this 
creates a completely new instance of the copied file and the result is that when you 
need to update the file, you have to perform that task twice, once for each copy. 
There are better ways to achieve this so please read on! 

8.4.4 Making a 'Clone' of a file the RIGHT way! 

So we now know its not great to copy and paste a file across folders but even so, 
sometimes you might need to show a file in more than one folder. For example you 
might want to show a Safeguarding Policy in TWO places at once? 

This is easy to do by using the Multi-Category feature. 
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8.4.5 The Multi-category option 

This useful option allows you to upload a single file into its main folder but then 
instruct Dropfiles to display it in more than one folder.  

At any one time, there is only ONE copy of your uploaded file which we might call the 
master copy. When we use Multi-category, Dropfiles creates a link to the master and 
sets it to appear in one or more additional categories that you can choose.  

With this in place, when you need to remove (or update) the master file, you only 
need to do it once - the link is either deleted or updated at the same time.  

This saves you time worrying and trying to remember if there is a copy of a file that 
you missed elsewhere! The neat part is that when you update the master, all links to 
that file are also updated. (see Working with Document Versions for how this 
works). 

8.4.6 Creating the Multi-category setting for a file 

When you select a file, it will show an orange border around it. You can now scroll 
down the righthand settings panel to configure the selected file to belong additional 
categories using the Multi-Category field. The screenshot below shows us setting a 
multi-category arrangement for our Safeguarding Annex A document so that it also 
appears in the Key Policies folder. 
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8.4.7 Removing a Multi-category setting for a file 

Select the file, it will show an orange border around it. You can now scroll down the 
righthand settings panel to the Multi-Category field. Note a small X in the Multi-
category choice in the panel: 

 

Click this X to remove the link for the selected file to the target Multi-category folder. 
Only the link is removed, the source file is still kept intact. 

8.4.8 Deleting files that are set as Multi-Category 

An important aspect of Multi-Category to be aware of is what happens when you use 
the Delete process.  

Let's consider our Safeguarding Annex from the image above. The original file is in 
the Safeguarding Category/Folder and we created a multi-category instance of it in 
Key Policies. 
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Let's assume some months have passed and we need to get rid of that file and we 
don't recall how we added it on day one.  

We know (from visiting the front end of the website) that the file can be seen on the 
Key Policies page and, sensibly we should look in that same titled folder in Dropfiles 
and try to delete that 'version'. When we select the file, we will see the blue notice in 
the right hand column: 

 

 

Dropfiles warns you that the selected file is actually a multi-category file and that you 
need to work on the original or master copy rather than its clone. It shows a blue 
button labelled "EDIT ORIGINAL FILE": 

 

If you click on the "Edit Original File" button, Dropfiles will take you to the folder 
where the original file lives and it will select the master file for you. 

Now, you will be able to safely delete the master file and the multi-category versions 
will also be deleted at the same time. 

Also... 

In addition, if you try to rename a linked file, the same thing will happen. A warning 
that you are trying to edit the wrong file and you need to edit the original master. 

But... 

It is possible to delete a cloned file in its folder! If you do this, the master is NOT 
deleted but the master's multi-category setting is removed. 

8.4.9 Deleting A File 
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Select the file(s) that you want to remove and click on the delete trashcan icon in the 
top bar. You’ll be asked if you want to confirm your request. 

 

Note that when you delete files, they are not retrievable. 

8.4.10 Download a File 

If you wish to download a file to check its content, you can select it in the List of files 
and click on the download option in the top bar. 

 

8.4.11 Select All Icon 

This icon does what it says on the tin; it selects all files in the selected folder so you 
can (for example) delete them all. Use this with caution! 

8.4.12 Uncheck Icon 

If you selected all or have several items selected, this icon will deselect all files. 

8.5 Working with File Versions 

When you have documents like Policies, you will often have new versions to add to 
the site, replacing older versions. There are a few ways to do this, each having pros 
and cons and you can decide which works best for you. 

8.5.1 Use Send a New Version method 

This is the recommended way to update a file to a new version. 
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Click the file you want to update and scroll down the right panel to see "Send a new 
version" 

 

 

Click the SELECT FILES button 

Find and select the new version from your PC or network drive and upload it. 

A message is shown to confirm the new version has been applied successfully: 

 

If you look in the Send a new version panel, you will see a new file has been added. 



 

131 

 

8.5.2 Pros and Cons of “Send a New Version” method. 

Pros: 

1. It’s easy so saves time 
2. You can restore the old version as its not deleted, its saved as an old version 
3. If the original file was set as multi-category, the new version will also be 

updated in the multi-category - you don't need to update the cloned one 
4. You will retain any potentially valuable download statistics data about the old 

file. 

Cons: 

1. You will perhaps need to edit the filename. If the new version is 2022 and the 
old is 2021, it will still show 2021 in the file Title field. Simply edit the title of 
the file and it will fix that for you and will update any multi-category files at 
the same time! 

8.5.3 Restoring an old Version 

This is done very simply. Use the restore icon (next to the trashcan icon) in the Send a 
New Version panel. Choose the date of the older version you want to restore and 
restore it. 
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You will be prompted to check you are ok to proceed with the restore: 

 

8.5.4 Deleting old Versions 

Over time you will perhaps start to have a particular file which has a growing number 
of old versions. This is not a problem for the website but from an administration 
standpoint you might find it cumbersome to deal with and house-keeping is always 
recommended if you have time! Therefore, you might wish to get rid of some of the 
old versions, perhaps only leaving the most recently added one. 

 

Here we see four versions. Note that the current live version is not in this list – what 
you are seeing is the earlier version list. 

To clean up this list, you can click the trashcan icon next to the older files (one at a 
time) to remove them. You will see a warning when you try to do this: 
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You should choose OK, and the old version will be removed from the system. 

8.5.5 Number of previous versions saved 

By default, the number of old versions saved is capped at 10. 

8.6 Managing a Single File 

Managing settings for a single file is as simple as clicking on a file and when you do 
this, the file settings are loaded at the right side for the selected file. 

 

 

This screen capture shows when we select a file, the details of that file show up on 
the right (we have split this into two columns below for easier viewing but in real life 
these settings are all in the one column) 
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Settings allow you to set values for the following attributes for the selected file: 

2. File publication status (is the file visible on the website or not) 
3. Editable File title (ideal if the original filename is in need of tidying) 
4. Description (rarely used) 



 

135 

5. File date of creation 
6. File date of modification (not editable) 
7. Start and Finish File Publishing Date : perfect for those times when you need 

to set a file to automatically show or hide itself 
8. File version (rarely used) 
9. Multi Category (for when you need a file to be shown in more than one folder 

but only want ONE instance of the file to manage. See Moving, Deleting & 
Cloning files 

10. File hits : useful to see how many times the file has been downloaded 
11. File tags (rarely used) 
12. File Direct Link : useful if you wish to add a web link to the file (but see more 

information below about adding files to articles etc.) 
13. Send a new Version (ideal for updating a document with a new version 

without having to delete the old one first). 

Remember... When you change the properties of a file, ALWAYS use the Save 
Settings button at the bottom of the panel. 

8.7 Adding Files to Webpages 

Adding and changing single files or (better) whole Categories of files to webpage 
articles (or modules) is actually very simple. You will likely need to do this if you need 
to show a list of files such as newsletters or policies on page of the website. 

8.7.1 Adding a single or standalone file 

To add a single file, (rather than a whole a folder's content) into an article (eg: to add 
a single Policy into an article), you do this by editing your article first. 

Go to Content > Articles and open the article in question in edit mode.  

In your article editor, click where you want the file to be shown, we think it’s a good 
idea for these to be on a line of their own, then click the "Files - Dropfiles" button 
which you will find below the editor window. 

Note that the Dropfiles button might be in a different position on 
different websites! 

https://itlookslikethis.co.uk/index.php/policies-newsletters-etc?view=article&id=33:moving-deleting-cloning-files&catid=13
https://itlookslikethis.co.uk/index.php/policies-newsletters-etc?view=article&id=33:moving-deleting-cloning-files&catid=13
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Clicking this button opens up Dropfiles in a pop-up window. 

Now, from the left hand column, select the Folder where your chosen file is stored 
and then click on your desired File in the centre panel to select it. 

Now, click "INSERT THIS FILE" which appears at the top of the right hand panel to add 
the selected file into your article editor. 

 

You will be returned to the article editor and your 'file' will be shown as a placeholder 
(a black panel with a download icon in the middle), within the editor. 

 

Now, if you have ended the desired changes for your article, click Save and Close and 
take a look at the results in the live website. 

The single file will be shown as a coloured link box within your article, 
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8.7.2 Changing a single file on a page 

You can change a file that is displayed in isolation on a page as described above. The 
most effective way is to use the Send a new Version option for the file (see above for 
how to use Working with File Versions). 

8.7.3 Adding a single file to look better in your article 

Above, we saw how we can add a single file to an article but we notice that the 
display for that single file does not match how files are shown when we display entire 
folders of files. 

For example, if you show entire folders of files on the web page they might look 
something like this: 

 

Or like this: 
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This is where we are showing then type category in table view. 

So, if you want to show a single file so that it appears as in the couple of graphics 
above, then the file in question will need to belong to a folder of its own. You can 
then (following the principles in Section 8.7.4 below) add this folder to the article. 

When you do this, you will simply create a new folder which will hold a clone of the 
file you want to display on its own. Give the folder a suitable title (maybe include the 
word clone in its name) and then set it to appear as a table or simplex view. 

Then, go and select the source file that you want to display on its own from 
whichever folder it lives in and once it is selected, use the right hand column 
properties for the selected file and scroll down to the Multi-Category chooser. Now, 
in the Multi-Category chooser, select the name of the new clone folder that you 
created so that a link is created folder (be sure to hit the Enter key to lock your choice 
in and then Save the configuration. 

Now, go back to the ‘clone’ folder – if you click it, you should see a copy of the file 
has been added to this folder. With the folder selected, now you can use the insert 
this category button at the top of the right hand column to insert it into your article, 
when you are editing your article. 

8.7.4 Adding an entire folder of files to an article 

To add a list of all files from a category of files into your article (for example: to add 
the full list of files in the Newsletters category into the article), click where you want 
the list of files to appear in your article editor for your Newsletters article, then click 
the ‘Files – Dropfiles” button, which opens up DropFiles in a pop-up window. 
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Now, select the category where your chosen files are stored and click “INSERT THIS 
CATEGORY” at the top of the right panel to add the selected Category into your 
article editor. 

 

The folder will appear in your article as a grey placeholder with a cloud style 
download icon. 

When you save and close the article and when the website is displayed in the front 
end, the placeholder is exchanged for a list of download files from your chosen 
category. 

8.8 Sorting /Ordering Files on your webpages 

8.8.1 Ways to Sort 

You can sort the order of files in a folder both manually (when you need them in a 
very specific sequence) or almost automatically. 

8.8.2 Manual Sorting 

File ordering can be done using drag and drop, just drag the file on the dashed line to 
define it's a new position in the file category. 
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8.8.3 Almost Automatic Sorting 

You can also sort / order all the files in a folder/category by clicking on the Folder title 
in the left column then choose the ordering you want using the parameters in the 
right hand column.  

An even quicker way is to click on the column heading in the middle column.  

For example, here we order the files by size, and this will cause a downarrow icon to 
appear next to the title. Once you made the ordering change you’ll notice in the right 
column, in category options the Ordering fields become blue to show your choice. 
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You have also the option to click on the column title to order file by: 

• Type 

• Title 

• File size 

• Date added 

• Date modified 

• Version 

• Hits 

Clicking the column title twice will set the direction of the ordering from Ascending to 
Descending (or vice versa).  
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8.9 Documents look weird on the webpage 

When you add documents to an article using Dropfiles, there are sometimes unusual 
things happen in terms of what they look like on the front-end. This page describes 
what you might see, why it looks like it does and then how to fix it. 

8.9.1 The normal view of documents 

Normally, documents on the webpage will look like the example below: 

 

Or… 

 

These views of documents (where you see single coloured panel with the file name 
and a download button or maybe an icon representing a PDF, the title of the 
document and then over on the right, a coloured Download button) is created by 
using the “Simplex” or "Table" theme settings for the Category/Folder in question. 

 

As you'll see earlier, the category or folder theme is set against the folder by choosing 
the Simplex or Table icon on the right-hand column: 
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However, if you create a new category/ folder within Dropfiles and you forget to set 
the theme to Simplex or Table in the right-hand column for the selected folder, then 
when you look on the front end at your documents they will look something like this: 
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This is because you failed to set the theme correctly and if you actually look at your 
folder settings in the right-hand column for the folder in question, you will indeed see 
that the default theme has been set for you: 

  

  

So to fix this particular issue, simply head to Components > Dropfiles, look for the 
folder in the left-hand column which contains the files which are being displayed 
incorrectly, select the folder by clicking it - this will highlight it: 

 

Then, look in the left-hand column to see how the theme is set. Simply click on the 
Simplex or Table icon/ image. You do not need to press the Save button, that's done 
for you when you change the theme. 

8.9.2 Other views that you might see 

You will notice that there are up to six themes available. When you first create a new 
category/ folder, it will automatically be set with the Default theme as shown above. 
You will now understand that we recommend that you always choose the Simplex or 
Table theme for the most appropriate view of your files on your webpage. 

If you inadvertently (or deliberately!) set the theme to one of the other options such 
as GGD ( which is short for Google Grid Documents) or. Tree, then the view will look 
like this: 
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The GGD View 

 

The Tree view 

8.9.3 Can I use these non-standard Views? 

Of course you can, your website and you can use whatever view you feel is 
appropriate. Simply bear in mind that the view that you choose may have an impact 
on how the outside world are able to access your downloads. 

8.9.4  Help! I'm seeing a completely different view to what I expect! 

If you look at a webpage having added Dropfiles to it and instead of the red PDF icon, 
title and download button being seen (as shown earlier), you see a rectangle with an 
unusual icon and text ( see the example below), there is a good reason for it! 
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What you are seeing is the Single File view method of displaying files. What this 
means is that when you uploaded your files into a Category/ Folder inside Dropfiles, 
what you then did was you selected the file that you uploaded and clicked on the " 
Insert This File" button in the top right-hand column.  

 

In other words, when you have files in a folder, you should use the Insert This 
Category button to force all the files in the folder to be displayed. 

8.9.5 The Workaround 

Given that it's not possible to show a stand-alone file ( which sits amongst a bunch of 
other files in a folder) in a more appealing way, we have a workaround which isn't 
difficult to achieve which will allow you to show the standalone file so it looks as if it 
belongs to a group of other files. We do this by creating a new category/ folder 
inside dropfiles and then we select the file in question in its original folder and we 
configure it to have a Multi-Category setting so that it also appears in your newly 
created folder. Here are the steps: 

1. Within Dropfiles, create a new Category/Folder. This folder will be added to 
the bottom of the list of folders on the left-hand column and will be titled 
"New Category". 

2. Hover your mouse over this new folder to see the Pen icon and edit the name 
so that it is relevant to your standalone file ( something sensible that you will 
be able to refer to easily), example Standalone Safeguard File 

3. If you need to, drag and drop this new folder up the list of other folders so it is 
easier to find. 

4. Now, find the file you want to show as a stand-alone file, do this by using the 
Search facility or simply navigate into the folder where it sits and select it 

5. With the file selected, look in the right-hand column at the properties for the 
file and scroll down that: until you reach the Multi- Category field. 

6. Click into this field and start typing the name of the new folder you created in 
(2) above [Standalone Safeguard File] 
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7. As you type the folder name will appear. Click it to select it so that it appears 
in the box. 

8. Scroll up or down in this column and click on the Save button. 
9. Now, click onto the folder that you created [Standalone Safeguard File]  
10. You will notice that the file that you set as Multi-Category is now appearing in 

this folder 
11. Now that you have created a link to the file you wish to be displayed in a 

stand-alone fashion, and it lives now in a folder on its own, you can now edit 
an article and at the place where you wish to show this standalone file you 
can use the Files - Dropfiles button at the bottom of the editor screen, select 
the folder Standalone Safeguard File, and use the button at the top of the 
right-hand column labelled. "Insert this Category". 

12. This will insert the category that only holds one file that you chose into your 
article. 

When you save the article and look at it in the front-end you will notice that it 
displays the stand-alone file that you created as a clone (Multi-Category), in the 
appropriate way. 

This is a workaround that works very well. We really don't recommend using stand-
alone files using the Insert this File mode of Dropfiles, but if you have to do it then 
the workaround makes things look much more attractive!  
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9. Calendars 
The website uses a Calendar Component called 'DPCalendar'. It is a fast, easy to use 
and fully responsive calendar and event manager with capacity to integrate 
Microsoft's Office 365 Calendar (if implemented). Where your website is NOT using 
an integration of MS Office 365 Calendar, the details below and on following pages 
will be helpful. 

Day to day events at school are easy to manage using the DPCalendar Component. 
Even if your website shows "School Diary", "Diary", "School Events" or 
"School Routine", this area of our help pages will be for you. 

9.1 Calendar Introduction 

9.1.1 Accessing your Calendar(s) 

Log into the website Control Panel and navigate to Components > DPCalendar to be 
taken to the Control Panel for the Calendar System: 

 

Note the seven feature buttons at the top of the screen (Manage Events, Add Event 
etc) 
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While you see seven buttons, only the first two are used (99% of the time!), and they 
are the Manage Events and the Add Event buttons. 

So, as these are the two key buttons, you can guess what you are able to do. 

9.1.2 Adding Events 

When you need to Add an Event to the Calendar, click the Add Event button. A form 
page will open that is used to create your new event, looking like this: 

 

 

9.1.3 Key Calendar Fields 

You will see a series of fields and tabs on this event editor form. The good news is 
that for 99% of your events, you only need to think about a small number of them on 
the Content tab. These fields are marked with an asterisk * and they are: 
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Title : Give your event a title, such as 'Parents' Evening' 

Start Date/Time : Choose the start date of the event and, if the time of the event is 
important, choose that too 

End Date/Time : Choose the end date of the event and, if the time of the event is 
important, choose that too 

9.1.4 Optional Choices 

Calendar : If you have more than one calendar (not often seen in Schools), use this 
chooser to select the calendar which this event belongs to. The default is usually fine 
to use. 

Colour: If you wish, you can associate a particular colour with this event. In some 
situations you may decide that a particular colour is associated with all holidays 
whereas a different colour is associated with assemblies and so on. To choose a 
colour, click into the field and a colour swatch will pop-up. Use your mouse to choose 
the colour from within this pop-up box and then click outside the box for the colour 
to be inserted into the field for you. 

Show End Time: If you do not know (or care) when the event will end, you can set in 
this field to No. 

All Day : If the event has no particular start or finish time and runs all day then you 
would choose all day to be Yes. 

Scheduling : If the event repeats on a regular cycle then you can choose from daily, 
weekly, monthly and, yearly. Depending upon which of these options you choose will 
dictate additional information that you'll be asked to provide. 

Description : You can add a detailed description about the event if it is needed using 
the description field. 

9.2 Editing/Deleting and Publishing Events 

Once you have a number of events, you might need to change them and the Manage 
Events button enables this. 
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When you choose Manage Events, the list of all events from 'today' onwards are 
shown (if you want to change the date range visible in the list, simply change two 
date fields). 

 

 

Select the event you want to edit and click its link (Title) to open the event in edit 
mode (see the Add Events page for help on this edit view). 

From here you can change any value of the event to suit your needs. Once complete, 
click in the Save & Close button in the top bar to commit your edit and to return to 
the list of events. 

 

9.3 Other Management Functions 
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When you see the list of events, you can perform other common functions very 
quickly, such as: 

9.3.1 Delete an Event 

To delete an event, tick the select box to the left of the event in the list and then click 
"Trash" 

 

9.3.2 Unpublish an Event 

To unpublish (hide) an event, tick the green check mark box to the left of the event to 
see it become a red cross (unpublished) 

 

By default, each event is automatically published so that it appears on the website as 
soon as you save it so to change this, in the event’s Publishing tab set the Status field 
to Unpublished. 
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Becomes: 

 

9.3.3 Set an event to go live in the future (aka Scheduled Visibility) 

There maybe special occasions when you need to prepare an event in advance but 
you do not wish the event to become visible on the website until a particular date in 
the future. 

To achieve this, create your event in the normal way and then, using the Publishing 
tab, set the Start Publishing field to be the date /time when you want your event to 
become visible on the website. 

 

 

9.3.4 Set an event to unpublish itself in the future 

If you need an event to remove itself from view in the future, using the Publishing 
tab, set the Finish Publishing field to be the date /time when you want your event to 
remove itself from the website. 
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10. Contact Us Pages 
Contact Us pages are handled in a special way in that they are NOT articles. In fact, as 
we have progressed over the years, we can create contact forms in different ways 
with different components, each with their own strengths. 

In general when we set up websites with a contact form page we use a specific 
component called Contact Enhanced.  

We sometimes use alternatives which are components as well, called: 

• Forms 

• Convert Forms 

We cover these two alternative form systems elsewhere in this guide. 

Your Contact Form page will be pre-set for you at the time of creating your website 
so all you need to understand is how to change it so suit your changing needs. 

Contact Enhanced provides special features that allow you to create a form very 
quickly by entering selected information such as: 

• Name 

• Address 

• Email Address 

• Phone Number 

• Miscellaneous Information 

10.1 Inspecting and changing contact form settings 

When you need to check or make changes to your contact form, you will need to use 
a component called Contact Enhanced. 

For example, from time to time you might need to modify information displayed or 
used on your contact page. To do this you will need to access the Contact Enhanced 
Component and then search for the contact in question so that you can inspect its 
configuration and change it accordingly. 
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To reach the Contact Enhanced component, click on Components > Contact 
Enhanced: 

 

When you open up the Contact Enhanced component, you will see the Contact 
Enhanced Dashboard screen first with its side bar options. 

 

Click on the sidebar where you see “Contacts”.  

This will show you, in the body of the page, a list of all the contacts that you have 
already had created (or that you created yourself). You can use the Search facility to 
look for specific names if needed. 

 

10.2 Change Settings for a Contact 
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To change information about a specific contact, such as to change their email address 
or name, click on their item in the list to put that contact into edit mode. When you 
do this the contact will appear in an editable form: 

 

Make the appropriate changes to the fields by editing them as needed and then click 
“Save & Close” to commit your changes. 

Your changes will take effect immediately. 

Test your changes particularly if you have changed the email address to 
ensure messages sent via your contact page arrive safely. 

10.3 Other Information you might see/edit 

10.3.1 Adding additional information 

There may be times when you want to add more information to your Contact Us 
page such as other contacts in school or a list of governors. This can be done in two 
ways" 
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10.3.2 Miscellaneous Info 

You can use the Contact Enhanced "Miscellaneous Info" tab for your contact to 
provide the additional information and then set the information to appear above or 
below the Map (or elsewhere). 

10.3.3 Using the Contact Enhanced Miscellaneous Info tab 

This tab appears to the top of a contact form page in the Components > Contact 
Enhanced component.  

Edit your Contact and click the Miscellaneous Info tab to see this: 

Doing this changes the display to show you (essentially) an article editor: 

 

 
Type or paste your text content into this editor panel and use whatever formatting 
you need for paragraphs and headings. 
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If you now save your edits and View the contact page in your browser, you will see 
that a title of "Other Information" and it is displayed usually at the very bottom of 
your page. 

 

When done, click Save & Close. 

10.3.4 Displaying the Miscellaneous Information elsewhere 

You can choose alternative locations were to display your Miscellaneous Information 
so it best suits your situation. 

10.3.5 Steps to change position of Miscellaneous Information 

Close the contact form editor (so you are now looking at the list of contacts,  

look to the top right for a button labelled "Options" 

 

Click this button and choose the Contact (or Single Contact) tab to see the general 
settings for a single contact form. 

Lower down this screen you will find the chooser related to Misc Information: 

 

In Joomla 3, you will see additional options: 
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In Joomla 3, you can set a different heading label for the Miscellaneous 
Info to suit our needs, 

In terms of ‘where’ you’d like to see the information, try each one in sequence, save 
your changes and see what it looks like on the front-end until you are happy with its 
position. 

10.3.6 Hiding the title 

If you do not want to see the title displayed at all, simply set the Misc. Info label field 
value to Hide 

Once you have made all the necessary changes, always click Save & Close 

10.3.7 Use a Custom Module to display more information 

Adding a Custom Module which will be set to appear in the right hand sidebar of the 
page is an alternative means to show additional data on your Contact page. Quite 
often we might place additional information related to contacting your school by 
using the sidebar on the Contact page.  The information shown might look like this: 
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This sidebar information labelled “KEY CONTACTS” is not part of the Component at 
all; instead, it is simply one or more modules set to display additional useful 
information in the sidebar position of the page.  Where this is the case on your 
website, we will have set that up for you. 

From time to time you might need to edit the information displayed in the sidebar 
and when this happens, proceed as follows. 

10.3.8 Editing the Sidebar Module 

Navigate to Extensions > Modules.  Note in our example above that at the top of the 
module is a title which reads "Key Contacts". 

Search the modules listed and when you find it, click on its title and edit It.  You will 
notice that it looks like a miniature article  and you can edit it to suit.  
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Save & Close 

Don't forget to use Save and Close when you have finished your changes. 
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11. Slide Shows 
Pretty much all our websites show a form of slide show on their home pages. These 
are large, often transitioning photographs that site at the top of the home page; ours 
looks like this: 

 

 

 

In this section we will show you how to create your first slide show if you need to but, 
more importantly, how you can change the slide images in your own slide show that 
we will have already created for you! 

You can think of these slideshows like a form of PowerPoint and in fact we 
recommend that you use PowerPoint as a way to create your slides that will be used 
on the website and we will describe below how to do that and then how to load the 
resulting images into the website slideshow system. 

11.1 How many images? 

We suggest no more than six to eight slides. If you have more slides that’s fine but 
you need to choose an optional setting on the website to ensure a level of ‘fairness’ is 
given to all of your images. 
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If you have dozens of slides, your web page will be slightly slower to 
load. In addition, the last slides will probably never get seen so we need 
to set the slideshow up slightly differently to accommodate these two 
issues. 

11.2 Getting images ready with PowerPoint 

We need to assume that you are familiar with PowerPoint (PPTX) and so we will dive 
straight in to creating your slides and the first thing we do is to set up your slideshow 
to be the most suitable size for your website slides. 

11.2.1 Setting the best slide size 

In PowerPoint, use the Ribbon and go to Design > Slide Size and choose Widescreen 
(16:9): 

 

11.2.2 Find and add images to PPTX 

Now, identify the great quality pictures which are a suitable size to be added to 
slideshow. These should be direct from your camera device and ideally should be 
almost the same size or larger than the PowerPoint slide. 

Add an image, one per slide, to your PowerPoint, don’t worry if the image is larger 
than the slide, we can sort that out next. 
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11.2.3 Position your images in PPTX 

When all of your images are added to your slides, move the images around in the 
slides by resizing them so the image fills the slide space with no white space left or 
right, top or bottom. 

 

Above you can see how when we stretch the image to fill the slide space, it overlaps 
at the top and bottom (we set the image to be semi-transparent so you can see it 
happening). 
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When this happens and we export the slide, it will export ONLY the slide area and the 
upper and lower image areas are cropped out. So, move the image to be sure the 
parts of the photo will not be cropped: 

 

11.2.4 Pixelated Images 

If, once resized, the image has become pixelated, then don’t use that image as it will 
look pixelated on the website. This will happen if you try to use a picture that is too 
small! 
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Once all images are positioned properly in each slide, its time to export them for use 
on the website. 

11.2.5 Exporting Images from PPTX 

Use File > Export and choose “File Format : JPEG” 

Choose “Save Every Slide” 

Set width to 1920 and height to 1080. 

 

Then click “Export” and a pop-up will inform you that a folder will be created 
containing your slides, numbered  starting slide01.jpg. 

 

 

 

If you navigate on your PC you will now find a new folder in the detailed directory 
and it will contain a number of images. 
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A very cool result of exporting this way is that the slides are 
automatically optimised! A hi-res photo that is 6MB becomes a slide of 
only 500KB once exported! 

11.3 Creating your Web Slideshow with Smart Slider 3 

Armed with your correctly sized and compressed photos, we can now head into the 
web control panel and start to build our slide show. 

We use a component called “Smart Slider 3 (SS3)” to create our web slideshows. 
Head to Components > Smart Slider 3. This will take you to the Smart Slider 3 
Dashboard (we have cropped the screenshot for simplicity below). 

 

11.3.1 Terminology 

In SS3 we use the following terms for our slideshow content: 

Project: A group of settings that define our Smart Slider 

Slider: The content of the Project 

Slides: The individual image slides in a Slider 

So, in SS3, we use a concept of a Project to define a new slider.  

11.4 Creating your first Project 

If this is your first project that you have ever setup, you will see a screen very similar 
to this below (the Tutorial Slider is there for educational use and you can investigate 
it at will). 
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11.4.1 Creating a New Project 

To start, click the green “NEW PROJECT” button. A popup panel appears about your 
new project: 

 

Click on Create a New Project to be offered the next options: 
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Choose Project Type > Slider 

Choose Slider Type > Simple 

In the Settings section give your slider a useful name such as “Home Page Slider” and 
set the height and width to 1070 and 600 respectively: 

 

Note the Layout chooser. The choices are “Full Width”, “Boxed” and “Full Page”. In 
general we always use “Full Width” but occasionally we can use “Full Page”. We 
never use “Boxed” unless special conditions so dictate. 

A full width slider will sit across the whole width of the web page that it 
is configured to appear on. You can alter the “Height” value so that the 
slider consumes less of the page if its too tall for your liking (see more 
later). 

A full page slider will take up the entire browser window regardless of 
the height setting. 

Now click “Create” to now see your Home Page Slider configuration screen.  
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11.5 Adding Slides to the Slider 

 

Inspect the top panel where you will see a box labelled “Drop Images here”. Drag and 
drop the images that you exported from PPTX into this box. Once done, you will see 
the slides in thumbnail view: 

 

11.5.1 Sequencing your Slides 

The slides are uploaded and dropped into the slider panel in no specific order (Slide6, 
Slide1, Slide etc). You can click and drag the slides into the correct sequence if it’s 
important to you to do that: 
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11.6 Adding more Slides 

When you have a slider with slides already in place but you wish to add more slides 
to it, click the “Add Slide” button to see a choice of slide types: 

 

 

11.6.1 Types of Slide you can add 

The icons above relate to specific types of slide as follows: 

Image (Default): Allows you to upload an additional image to be displayed in your 
slider 

Blank: Creates a new blank slide that you can use for other purposes 

Post: Allows you to add a slide that will display an Article from the available articles in 
your site 

Static Overlay: Creates a slide that is transparent and will sit in front of your slide 
show and can hold text and images that are static while the images transition below 
it 

Dynamic Slides: Not used. 
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The most common of these choices is “Image” which is where you add a new image 
to a new or existing slider. 

11.6.2 Adding an Image Slide 

Before you go any further, look below the thumbnails panel to see information like 
the following: 

 

Note that the Slider has automatically been given an ID of 3. Yours may 
will be different but whatever the number you see, memorise it as it will 
help you in the next step. 

Click the green Image button. A screen appears which shows all existing images and 
image folders. Look for a folder labelled “sliderX” where X is the ID number for your 
slider. For us we are Slider ID:3 so we look for a folder labelled slider3: 

 

Click into the appropriate folder to see all images that have been uploaded to that 
slider so far: 

 

Drag and drop your additional file(s) [multiple images can be dragged and dropped at 
the same time] into the dotted box labelled “Drop files here”: 
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We uploaded a couple of almost identical canal photos (slide31 and slide41). 

Now, to include one of the uploaded photos into our existing slider, simply click an 
image so that a coloured border appears around it and then click “Select” from the 
top row.  

 

To add multiples, click each and hold the CTL key at the same time: 

 

When you click Select, the Select Image screen will close and your chosen images will 
appear in your slider screen: 
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11.7 Slide Image Actions 

Looking at your slider, if there is an image you no longer want to be displayed, hover 
your mouse over the selected image to see three dots appear in its top right corner.  

 

Click the three dots to see a pop up panel appear showing choices: 

• Duplicate 
• Copy 
• Unpublish 
• Set as first 

• Delete 
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Choose Delete upon which a warning will appear 

 

Interestingly, while the warning indicates that the slide cannot be 
recovered if its deleted, this isn’t quite true! The image itself will remain 
in the sliderX folder so you can reuse it if needed. This might change in 
future software releases. 

11.7.1 Unpublishing Slides – an Alternative to Deletion 

Rather than deleting a slide from a slider, you might consider it better to simply 
unpublish it. This keeps it in the slider but will not display it in the front end of the 
website to the public. 

To unpublish a slide in a slider, hover over it to see the three dots, click them and 
choose “Unpublish”. 

An alternative way to do this is to click on the green tick (lower right of each slide) to 
grey the slide out and unpublish it: 

 

11.7.2 Republishing an Unpublished Slide 
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If you later need to reactivate an unpublished slide, click the grey X (lower right) to 
set the slide state back to Published. 

11.7.3 Setting your first slide 

If you want a slide to appear first in the display when visiting the website, you can set 
it as First Slide.  

When this is done, a gold star is shown in the slide to denote its status. 

 

Here Slide41 will appear first even though it is not first the array of images! 

11.7.4 Duplicate a Slide 

A rare activity but occasionally you may have reason to create a duplicate of an 
existing slide without uploading it again. 

To do this, use the three dots and choose “Duplicate”. This will create an exact copy 
of your chosen source slide. 

11.7.5 Copy a Slide to a different Slider 

If you have several sliders set up in your website, you might need to copy a great 
slide from your slider to one of the others. To do this, use the three dots and choose 
“Copy” and a popup will appear will a display of all of your sliders: 
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Click on the image of the destination slider to add the copy into and click “Insert”. 
The selected Slider will open in Edit mode where you can manipulate the slide you 
copied over. 

11.8 Adding Text to a Slider 

It’s often good to have some text that overlays the slider that welcomes visitors and 
perhaps provides additional information. This is done by adding a Static Overlay slide 
to your slider.  

11.8.1 A note about Fonts 

Part of making your slider ‘special’ is to choose fonts that are classy and professional. 
Smart Slider 3 comes pre-equipped with the option to use Google Fonts where you 
can choose from dozens of elegant and robust font faces for your heading and text 
on your overlays. 

The following is advisory only and is not something you would do on a 
day to day basis, if at all. 

To see what fonts are available at the right side of the Header bar you can reach 
the Global settings: 

 

Click Settings 

https://smartslider.helpscoutdocs.com/category/1707-global-settings
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Most of the Global Settings are fine as default. The only possible option that you 
might want to change is under the Fonts page. 

 

On this page you can choose the font you want to be the default for Headings and 
Text when they are added to your Overlay Slider. If you know the name of the font to 
use for these, delete the content in the Default Family field and type in the name of 
your chosen font. Click Save when done. You might like to ask us for support on this 
though! 

 

 

11.8.2 Adding a Static Overlay Slide 

Earlier we saw that when you have a slider with slides already in place that you can 
add more slides to it by clicking the “Add Slide” button to see a choice of slide types: 

 

The Static Overlay option creates a slide that is transparent that will sit in front of all 
of the slides in the slider show like an acetate in traditional slideshow. Static Overlays 
and can hold text, images, buttons etc. that are static while the images transition 
below. 

When you click the Static Overlay button, a new Green slide is added to your slider: 
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You can now edit the static overlay slide to include text and other content. For ease 
of supporting you in this guide we will detail how to add a Welcome section and a 
sub-section for a message under the welcome panel. 

11.8.3 Adding text to the Static Overlay Slide 

Start by clicking Edit when you move your mouse over the green Static Overlay slide. 
The Slide opens up in edit mode showing the first slide in the array on show behind it 
(purely for reference and alignment). You can’t edit the underlying slide! 

 

The dark slide panel shown can be dragged out of the way as you work so that it 
doesn’t get in your way as you make changes to the slide. 
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11.8.4 Slide Overlay Tools 

Down the left of the slide are a set of icons: 

[+] : We call this “Advanced Tools” as this allows you to add a new transparent layer 
with any form of content or to apply a theme to your overlay in case you want to 
have special things happening in the slide like movement or special animation of 
content on a layer. The themes are predefined concepts of predefined images and 
text that you can use and adapt to make your own slides more polished.  

We can’t easily cover all the possible themes and choices available under the [+] 
button so we will leave you to enjoy experimenting with these on a text slider that 
you can make in your own time but below we list them for you! 

11.8.5 Advanced Tools 

As mentioned, the large number of possible tools you can use is significant but we list 
them below. 

Click [+] and you will see a number of choices: 

Basic Tools 

- Row 
- Heading 
- Text 
- Image 
- Button 
- Icon 

Special Tools 

- Image Box 
- Animated Heading 
- Highlighted Heading 
- Caption 
- Transition 
- List 
- Progress Bar 
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- Circle Counter 
- Counter 
- Countdown 
- Before/After 

Media Tools 

- Vimeo 
- YouTube 
- Video 
- Audio 

Advanced Tools 

- Image Area 
- Area 
- Iframe 
- Input 
- HTML 

 

11.9 Common Slide Overlay Editing tools 

H : This adds a heading block to your slide overlay 

Text : Shown as a set of lines, this represents that you can add free text to the slide 
overlay 

Image: Add an image to the slide overlay 

Button : Shown as a box with a single line in its centre, this will insert a button that 
can be used to reach elsewhere in the website or externally 

Row : Shown as a box with two white panels, this will add a new row to your slide 
overlay with two equal columns in it that you can add content to. 

We will look at each option below. 

11.9.1 Add a Heading to the Overlay 
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This is likely the first thing you will add to your slider. A Welcome banner in a heading 
style is a great place to start. To make our example easier we have set our Canal 
image as our first slide (we dragged it into first place) so we can see how text looks 
on top of it: 

 

We have dragged the control box to the right so we can see all of the slide. 

Now we click H in the toolbar and it automatically adds a layer with “Heading layer” 
in it as an overlay (cropped image below) : 

 

If you now click the text, a blue border appears to show it is selected to be edited: 

 

The control box now shows the ‘properties’ for the layer and this is where you can 
edit the text, size, font, colour and many other attributes. Let’s take a look at a few. 

11.9.2 Text Title 
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The text box shows the words being displayed on 
the overlay so we will change it to read “Welcome 
to Canals 2024!” by deleting the text in the text box 
and typing in our new required text. 

 

The resulting slide now looks like this: 

 

We might like to make the text larger or bolder. To do this, click on the Style icon (has 
a paint roller icon) to see a large set of options for the text style. The first area to look 
at is the TYPOGRAPHY section: 
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Here you can choose a different font by clicking into the Family field to see a drop 
down list of all available other fonts. If you choose a different font, the results will 
appear immediately in the slide panel. Let’s change the font to “Oxygen”: 

 

The result looks like this: 

 

To make the text bolder, use the “Font Weight” chooser. Make choices to see how 
they change the look of the text. Some will have little or no effect, other will have a 
major impact. 

 

If you want the font to be larger, the Size chooser is used. The default font size for 
the heading is 36px as shown above. Let’s increase it to 54px: 
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Looks great! 

Now how about we add some subtext under the heading! 

11.9.3 Adding Subtext 

Click the Text icon in the side toolbar (4 lines). This auto adds a block of text with 
“lorem ipsum” nonsense text it to show where it is and what it could look like. It also 
adds a hyperlink (in blue) for additional fun. 

 

So far so good but the text is too small and the block it is in is too wide – its too close 
to the edges of the slide. Let’s fix that. 

Click the text block to select it (it gets a blue border): 
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When you do this, the control box shows the content, just like it did for the heading, 
so now we can edit the text for our slider subtext. 

 

11.9.4 Changing Font Size 

And now let’s increase the font size to make it easier to read using the Style icon. 

We will change the font size from 14px to 28px: 

 

 

 

11.9.5 Making the text block less wide 

But now the text is a very wide section and it looks awkward so lets reduce the width 
of the text box to be more attractive. We can do this by eye by selecting the text 
block where you will see two white dots left and right of the block: 
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Click a white dot on left or right and drag it in to the middle of the side until you are 
happier with the way the text looks against the heading: 

 

Now, the text block is the same width as the text in the heading block and looks 
much smarter! 

At this stage we might decide we are completely happy with our overlay slide and so 
we can preview it! 

11.9.6 Save & Preview your Overlay 

First click Save in the top header row: 

 

Now, to get a quick preview of your work, click the EYE icon in the same row. A page 
will pop up showing you your slide with the overlay in place. 

11.10 Large Text in Small Screens 

When you create a slider with text overlay, you need to bear in mind that different 
devices like Mobiles will need handling so the text isn’t too big or small for them 
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when the slide loads up. This is done using the ‘Responsive’ settings for each text 
block. 

11.10.1 Large to Small Screen settings 

The heading block text will look over heavy on a small screen so we need to make 
adjustments to it so when viewed on a mobile device, it auto resizes the text. This 
also applies to the subtext and other objects you might add to the Overlay slide. 

11.10.2 Using the Responsive settings 

First, hover your mouse over the PC icon in. the header (next to the EYE icon) to 
reveal a chooser: 

 

You will see three icons. A Mobile Device, A Tablet Device and a Laptop Device. The 
Laptop is the default view and this is what you see in the display. If you now click on 
the middle tablet icon, the screen changes to show what a Tablet use will see: 
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This is fairly ok but we might like to reduce the font sizes slightly so they are less 
overbearing in the tablet screen view (its all subjective!). To do this hover your mouse 
over the Heading block to see two A characters representing text sizes. 

 

Click on the dual A icon to see a slider: 

 

This tells us that at the moment, the text is 100% of the size set for the default 
heading size (54px). We can reduce this by sliding the slider to a lower value. We will 
choose 80%: 

 

This is better! 

We can now do the same for the subtext block. 
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We can also reduce the width for tablet views by adjusting the block width as we did 
earlier:  

 

So now our tablet view is essentially a scaled down laptop view! 

We now (and lastly) need to do the same for Mobile devices. 

Click the responsive icon for Mobiles 
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Now perform the same font scaling as we did for the heading above, choosing 
suitable scale sizes for the heading block and sub text block when viewed in a mobile 
device. 

We often find that a reduction in scale down to 40% is ideal! 

 

Now SAVE your changes and use the EYE icon to preview your slider and you should 
find it looks great in all possible sizes and rotations! 

11.11 Project Settings 

Once you have added your slides and an Slide Overlays and once you have checked 
all look great in responsive modes, its time to tell the slide show project how to 
behave! 

Save your slider again (to be sure) and click the BACK button to return to the Slider 
settings page for the slider in question. Under the Slides you will see a set of tab 
options: 
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11.11.1 General Settings Fields 

This option is used to define how the slider is published, as a Module, as something 
added to an Article or as PHP Code. The common uses are Module and Article but we 
do this for you! 

11.11.2 General – Simple Slider fields 

Under the Publish section is the General – Simple Slider fields. There are three fields: 

Name : the name of your slider project which you chose at the start 

Thumbnail : You can click the [+] icon and choose an image to be the thumbnail for 
the project (Not a key field) 

ARIA Label : Use the same text as for the Name field. This is used by screen readers 
to tell visually impaired viewers what is there. 

 

11.11.3 Alias field 

Alias: Use the same text as for the Name field. This is used by Search Engines to tell 
SEO what is here! 

Use as Anchor : Not used by us. 
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11.11.4 Slider Design fields 

The fields in this section can all be left as default unless there are specific reasons 
otherwise. 

12. Adding Video 
This section will help you with adding single videos to web pages. You will also find 
support for adding Playlists from YouTube to your web site. 

12.1 Can I just upload my videos directly to the website? 

Not necessarily, and here’s why. 

Imagine that you have taken a video recording on a mobile device or some other kind 
of recorder and you'd like to add it to your website. Depending how long your video 
is in minutes will determine how large the video file is in megabytes and this is 
important in respect of whether you can upload your video directly to the website or 
not. 

In general it's not a good idea to upload your videos directly to the website like you 
do with images. Quite simply, videos can be huge! 

Unlike an image which might be up to 1 or 2 MB in size, video which lasts 10 or 15 
minutes (let's say it is a class assembly video) could be 1 or 2 GB in size (a thousand 
times larger)! Even a one minute video recorded in high quality can be as much as 
160MB (see this video size calculator). 

Unfortunately, the website will not allow you to upload files as large as that and you 
wouldn't want to because it would simply consume too much of your available disk 
capacity/space. For this reason, we always recommend that you upload your video 
files to YouTube, using your own school private YouTube channel. Once you have 
uploaded your video to YouTube, you can then embed the video code that YouTube 
provides into the webpage quickly and easily. 

12.1.1 What if it’s a large video? 

https://www.omnicalculator.com/other/video-size
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If your video is large, as noted above, you are recommended to upload the video to 
YouTube and work from there. We have a page dedicated to working with YouTube 
videos which are confined in the sidebar. 

12.2 Adding a small local video to your Article 

Remember - LOCAL videos must be very small files, no larger than 32MB 

If your video is only small (maybe around 30MB or so) it is possible that you could 
upload the video directly to the website in a similar way to how you would with an 
image. The key difference is that when you edit your article to insert your video, 
rather than clicking on the Insert Image icon you will need to click on the Insert 
Media icon. 

With your video stored locally on your computer you will need to upload it to the 
Web server. The Insert Media icon is found on the bottom row of the toolbar panel: 

 

Now, inside your article put your cursor at the place where you want to show your 
video. 

Next click on the Insert Media icon in the toolbar, It looks like this 

 

 
this will present you with the Insert Media pop-up window: 
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Navigate to an appropriate folder within the left panel or, better still, use the black 
New Folder icon to create a new folder in which to upload your video. Once you are 
in the appropriate folder, click on the black Upload icon icon: 

 

You will be presented with the Upload panel: 

 

Note that this example shows that the maximum file size that you can 
upload is 32MB. Your site may show a different value! 
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Now, click on the green Browse button and navigate to the video file on your 
computer. When you have chosen it, use okay or continue in order to accept it. Its 
filename will appear in the Upload box, 

Now click the blue "Upload" button (next to Browse) in the panel. You will notice that 
a progress bar is  displayed and your video, depending upon its size, may take several 
minutes to upload. Do not close the browser or the upload panel until the video 
upload has been completed. Once completed, the upload panel will disappear and 
you will be returned to the Media Manager pop up. 

Your video which you uploaded will be selected in the centre column. All you need to 
do now, is click it again such that the URL field (at the top of the box) changes to 
show the full address of your video file. 

Set the values in the Dimensions panels to 800 x 600 for a sensible size for your 
video. 

Now, click the blue Insert button to insert your video as a placeholder inside your 
article. 

Notice that you will not see the video in the editor screen however a pale yellow 
placeholder will be shown to represent where the video lives. 

Now, save your article and go and view it in the front of the website. 

All being well, your video will be displayed and you can click it to play it. 

 

 

12.3 Adding YouTube videos (Step 1) 

Last Updated: 29 January 2024 Hits: 2 

Once you have captured and (if needed) edited your video clip, the process of adding 
video to an article has two major steps: 

Upload the video to YouTube to obtain a unique URL for the video 

Add the URL to your article 
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12.3.1 Uploading Video to YouTube 

Every school has a YouTube channel if they use a Google calendar because Google 
provides a YouTube channel as part of its account for you. If you don't do this or 
don't know if you do, drop us an email and we will help you out. 

The first thing you need to do is to login to the Google account for your school and 
once logged in, use the application's icon in the top right and click on the YouTube 
option: 

 

your website URL in the browser address bar will now change to something 
like  https://www.youtube.com/?gl=GB 

Next, click on the upload icon which is presented as a camera icon in the top bar, 
under the address bar: 

 

Not been here before? 

https://www.youtube.com/?gl=GB
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If this is the first time you have used your YouTube channel, you will likely be 
prompted to create it. A channel is where all of your videos will be stored. Follow the 
instructions on the screen until you have completely created your channel and then 
you can move onto the next step below. 

When you click the camera icon will see options to Upload Video or Go Live: 
 

Choose Upload Video and an Upload 
panel appears: 
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Click "Select Files" or drag and drop your video(s) into the panel and it/they will start 
to upload. 

You can add more than one file at a time if you need to, it will just take longer to 
upload and will keep you waiting. 

As soon as you have chosen the first file, it will start to be uploaded and then it will 
be processed. Depending upon the size of your video, the upload and processing 
activity duration could take several minutes so please be patient. 

If you close the window halfway through the upload the video will not complete. 

Be patient! Large videos can take several minutes to upload!! 
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Once the upload starts, you will see a new panel appear and it will have the file name 
of your video at its heading. Its a good Idea to give your video an informative title 
-  not too long though! 

 

As you look at this panel, you will see a section for 'Playlists'. If you have or want to 
create a Playlist (to hold related videos), you can assign or create one here by clicking 
the Playlist pulldown-option: 
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 In my example above, I might add videos for Bridgwater and always tick the 
Bridgwater playlist tick box so that later I could display all of their videos on one 
page. 

You will also note an area related to Audience. We suggest that you always choose 
"Yes its made for 
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Kids".

 

Now, click Next. 

The next page is called Video Elements which is not really used in Schools so you 
can  bypass this page and click Next. 

The next page relates to Checks.  Again,  you can bypass this one for now and 
click Next. 

The third and final panel is labelled Visibility, where you choose when to publish and 
who can see your video. 

Set the  Save or publish option to Unlisted. 

What this does is ensures that videos which you add will not be available in the 
YouTube search facility. It will however allow us to add the video to a webpage by 
embedding its URL address. 

12.3.2 Things to note 

1. Getting the video URL 
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You will notice that as soon as the upload starts, you'll be given a video link, shown 
on the left-hand panel of the window: 

 

This is the URL that you will add to your web article! 

Use your mouse to select and copy this entire URL 

2. Thumbnail 

When the video has completed uploading and processing, YouTube will choose three 
thumbnail frames at random to be used as the 'poster frame'  that you see when the 
video first loads and before you play the video. You can choose a thumbnail from 
those offered in the display.  You can also create your own thumbnail and upload it if 
you need to do so! 

3. Video Description 
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The video description is not mandatory but it is very important that you give your 
video a suitable title which tells the viewer exactly what the video is about. If you 
don’t, the video file name will be used by default and if the video filename is 
23_09_2020.MOV, that will be a somewhat ugly  and meaningless title! 

Now that you have uploaded, processed, thumbnailed, titled and maybe described 
your video, you can click the DONE button and you'll be presented with a window to 
show the video is bing processed etc: 

You can click CLOSE at this point. 

You can now switch to your website as you are ready to add the video URL to an 
article. 

12.4 Adding YouTube videos to an Article (Step 2) 

Insert the URL code for the video into your article 

Edit your article and put your cursor at the place where you want to show your 
YouTube video. 

Now, simply use CTL_V (Paste) to paste the YouTube video URL directly into the 
article. Its as easy as that! 

Experiencing difficulties pasting the URL? 

Now, inside your article put your cursor at the place where you want to show your 
video 

Click on the Insert Media icon in the toolbar, It looks like this 

 

This will present you with the Insert Media pop-up window: 
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Click into the URL field and paste in your Yo```uTube URL. The Media Type field will 
automatically change to read YouTube and the dimensions  fields will also  change to 
automatically set to predefined video size. 

Now, click the blue Insert button to insert your video as a placeholder inside your 
article. 

A clever feature for YouTube videos is that when you insert them into an article you 
will actually be able of view them directly in the editor. 

Now, save your article and go and view it in the front of the website. 

All being well, your video will be displayed and you can click it to play it. 
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13. Weblink Lists (incl Sway) 
 

Our  page of information related to adding Hyperlinks to an article  describes how to 
add an isolated link within the body of the page such as a discrete link to the BBC or 
Google.  This is okay but what if you need to add a list of web links?  What if you want 
the same web links list to be displayed in different places across your website?  it 
would be hard to have to create the same list over and over again just to show it in 
different places! 

Your website can display a list of web links on pages. these are different to web links 
which you might add as part of an article for example, when you add a link to a 
county council website or to Google. 

Understanding the difference between individual web links with weblink lists is 
important because with lists, you can have a whole page full of web links which can 
be usefuly grouped together for parents of pupils. 

13.1 Creating and managing web links 

We use the Web Links Manager to create, edit and remove weblinks to web sites 
which will then be displayed as lists of links on your web site. They are organised into 
categories or groups so that you can  decide to show links from a particular category 
on a particular page. 

13.1.1 Weblink Categories 

Categories are used to group together similar items of content and this applies to 
web links so that we can then show them on the website, all grouped together.  

13.1.2 Create new Web Categories 

To create new categories for your web links you use the Components → Weblinks → 
Categories option from the drop-down menu of the Control Panel. The resulting form 
that you will fill in is very simple. You only need to give the category a title and then 

https://itlookslikethis.co.uk/index.php/articles-incl-tables-publishing/adding-hyperlinks-webkinks
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save and close the category. You can use any name that you like for your 
Category!  Once you have created your Category, click Save & Close. 

13.2 Creating and Editing web links 

To add weblinks, access the Web links Manager. Go to Components → Weblinks → 
Links from the drop-down menu of the Control Panel. Below is a screenshot of an 
example Weblinks Manager showing a small number of existing weblinks. 

 

Whether you add or edit a weblink, the same editor form screen is used. 

13.2.1 Add a New Weblink 

To add a new Weblink, click on the  "New" button in the Weblinks Manager 
toolbar.  the  Web Link: New  page appears. 
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13.2.2 General Information 

Using the form above you enter basic link information and we have itemised below 
for clarity.  Those in red, and mandatory fields. 

Title. The Title of the weblink. This field is required and is the English link that will be 
shown which visitors will click. 

Example: Sway Newsletter May 2023 

URL. The URL of the weblink. This must be the full URL, including the starting http:// 
(or https://) 

Example: https://hereistheurltotheswayletter.co.uk 

Description. The description for the item (optional). These descriptions are entered 
using the same editor that is used for Articles. Only certain areas of the website will 
show these descriptions and these are never shown where weblinks are in the 
sidebar of a page. 

Example: In this month's edition, we update you on the new school build of the 
swimming pool! 

Status. Published/Unpublished etc. The published status of the item. 

Example:: Published 

Category. Choose the Category this item belongs to. 

Example : "Sway Newsletters" (or similar) 

The final task is to configure the new link so it always opens in a new blank tab or 
window (so the school website is not overwritten when the new site is visited). 

Click on the “Options” tab. Then, use the Target drop down chooser and set it to 
show “Open in new Window” 

https://)/
https://itlookslikethis.co.uk/weblink-lists
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Once you have added (or edited) the title, the URL and the category as a minimum, 
you can save the weblink. 

13.3 Sway Weblinks 

When you create a new Sway newsletter, a new URL will be created for it.   So, when 
you need to add it to the website, you will simply need to add a new web 
link.  Whatever you do, don't edit an existing Sway web link  from previous 
publications as this will overwrite it altogether. New is the way! 

13.3.1 Adding new Sway Weblinks 

With our SWAY example, You will add a new web link for each sway newsletter. The 
title will probably reflect the month and year of the newsletter but the category  will 
always be related to the Sway Newsletter.  Of course, the URL  for each 
Sway  newsletter will be unique. 

SAVE YOUR LINK 
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Now, you can click ‘Save and Close” to save the link. It will now appear on your 
website wherever it is designed to show. 

13.4 Make a link open in a new window 

"When I add a weblink, it overwrites my page" 

When you create a web link (or hyperlink to give its proper terminology), it can be set 
to open in one of two ways 

Open in a new window or tab of your browser - this is an external hyperlink. 

Overwrite the page you are on with the new linked page - this is an internal 
hyperlink. 

There are more but these two are the most common. 

The former is  always used when linking to different website, for example linking 
from your website to Google. 

The latter is always used when linking from a page on your site to a different page on 
your site, for example to link from your home page to your contact us page. 

So, when you create your link, you will see as part of the settings, 
an option for Target: 
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The choices are easy to see in the chooser to help you pick the correct target for your 
link: 
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WHERE WILL YOUR LINK END UP (THE 
DESTINATION) 

TARGET CHOICE SETTING 

External website such as BBC Open in a new window 

A page within your website Open in parent window 

Don't forget to save and close your settings as needed! 
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14. Adding Galleries 
Adding galleries the photographs or other images to your webpages is a great way to 
display multiple pictures which are shown as thumbnails. When you click a 
thumbnail, the full-sized image appears in a pop-up window. Adding galleries is quite 
easy and is often a simple way to add images to articles. 

There are two features of our websites that you can use to add galleries of images to 
your webpages. These are shown in the right-hand sidebar as Simple Image Gallery 
Pro and as Droppics. 

We find that the Droppics  method is easier to use.  If you find that this 
option is not available on your website, please contact us and we can 
install it for you free of charge. 

A word of caution about the number of pictures in your gallery 

While galleries are super ways to display groups of images, if you add too many 
images to your gallery on any one particular page, you risk slowing down how quickly 
the page will load. Our experience tells us that if you have a gallery, it's best to have 
no more than 12 images in the gallery. 

Another word of caution about the actual size of the images that you add to your 
gallery 

Another factor which will affect how quickly your page will load is not only how many 
images you have in your gallery but also the physical size in megabytes of each 
image. We can show you a clever way to automatically resize your images when you 
upload them so that when you and your gallery to your article you can be confident 
that the images are already optimised for use on the website. 

14.1 Using Simple Image Gallery Pro 

Note: We are in the process of phasing out Simply Image Gallery Pro 
(source developer no longer providing updates). If you want to add a 
web gallery to a page we recommend using DropPics. 
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The basic principle of adding a gallery to your webpage ( i.e., within an article) is to 
place your cursor where you would like your gallery to sit and then use the Simple 
Image Gallery Pro (SigPro) button which sits underneath the editor screen to then 
insert your gallery. 

 

Clicking this button causes the SigPro application to appear in a popup screen where 
you can choose the gallery to add to your article. 

The system will now put you into your own personal gallery area which is based on 
your login username. Depending upon whether Galleries have already been created, 
you may see one or more existing gallery thumbnail images. 
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If you have never added galleries before then the system will tell you that no galleries 
exist. In either case, at the top of the page you'll see a green button labelled New 
Gallery. 

 

14.1.1 Naming your gallery folder 

Click this button which causes a pop-up window to appear asking you to enter a 
folder name. 

Use the Month and Year in your folder name 
 

It's highly recommended that you prefix the title with the month and year when you 
are adding the gallery. 

Use the Article Title for the Folder Name 
 

It's also a great idea to use the same name as your article so, if your article is 
called September Conker Adventure, then you would use the same title as the folder 
name for your gallery. So, ultimately if it is July 2022, you would have a folder name 
as follows: 
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When you click the Proceed button, the system will check if your folder name already 
exists and will also check for any invalid characters in your folder name. For example, 
the system will not allow characters such as full stops and commas and other 
punctuation marks your file name if it finds one of these, you will see an error such as 
below where we have added an exclamation mark at the end of the folder name. 

 

If all is well, you click the Proceed bottom, the new screen will appear reporting that 
"This gallery does not contain any images", and you will be prompted to click the 
green Add Images button so that you can upload some images: 
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14.1.2 Adding your images to the folder 

Click the green Add Images button. Another new pop-up appears allowing you to 
drag and drop or select files from your device/PC into the grey area where it says 
Drag Files Here. See the image below. 

 

Rather then drag and drop your files, if you prefer you can click the green Add 
Files button to navigate your device/PC and find / select the files that you are 
interested in for your gallery. When you have either dragged and dropped your files 
or select them, they'll be shown in a list: 
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. 

If you need to, you can delete images from this list by using the red X icons against 
each image. 

Now, click the grey Start Upload button and the pictures will be uploaded from your 
computer into the folder that you created. 

You will see the images appear behind the upload window. When all the files have 
been uploaded, you can close the window (use the black X button) and you will see 
your gallery images displayed. 

Again here, if you need to, you can delete images from the gallery by using the tick 
boxes on each image and then click the Delete link above the images. 

Note that you can also delete images by clicking the trashcan icon in the lower right 
corner of an image. 

14.1.3 Adding Titles and Descriptions (Optional) 
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Each image can have a short (4-5 words) title and under the title, you can also add a 
description. The description should be short and to the point! 
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Note that this step is optional – titles and descriptions are useful but not essential, 
but they are really useful if your images relate to different parts of your blog post! 

If/when you have added titles and descriptions you can now click the Save and 
Close button in the top corner: 

 

You have now created your gallery of images and it is represented as a single 
thumbnail image of the first image in the gallery. This is purely a representation of 
the gallery and the gallery thumbnail will show you a number in the top right to 
confirm the quantity of images in your gallery. (Note by the way that images are 
sorted alphabetically). 

 

14.1.4 Inserting your Gallery into your article 
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Once you have created your gallery and you can see the thumbnail representation 
you can now insert it into your article. To do this, hover your mouse over the 
thumbnail and you'll see that two icons appear, overlaid on top of the thumbnail, 
labelled Insert and View 

 

The view option is used to look at the images in the folder so that you can either 
delete them, add new ones or amend any titles or descriptions. See below for Editing 
your Gallery. 

Click on the insert option and your gallery short code will be added to your article 
(the Simple Image Gallery Pro panels will close and will return you to your article). 

The short code which is added to your article will have a specific format such 
as {gallery}foldername{/gallery} 

This shortcode is used by the website when it is being viewed by the public. It 
instructs the webpage to load whatever images are found in the folder defined 
between the two {gallery} markers. 
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14.1.5 Editing your gallery 

Even after you have published your gallery on your page, you can still return and edit 
it and you can do this in two ways: 

Method 1: Simply go to the article which contains your gallery and click on the SigPro 
button at the bottom of the editor panel. 

Hover your mouse over your chosen gallery and click the “View” icon. You can then 
make changes to your gallery by adding new images, deleting existing images, adding 
titles and descriptions. When you have finished making your changes, click Save and 
Close. 

You don’t need to make any changes to the article itself so you can simply save and 
close the article 

Method 2: The other way to edit the images in your gallery is to go directly to the 
gallery component itself. 

Click on Components >> Simple Image Gallery Pro. Again this will present you with all 
your galleries and you can then follow the same procedure as for method one in 
order to edit your images in any particular gallery. Note that this method means you 
don't have to touch the articles at all! 

14.2 Using Droppics Galleries 

The first thing you need to realise is that you can  access the 
Droppics  system by going via Components >> Droppics.  This will lead 
you to the ability to create new gallery folders and add images 
directly.  The alternative route is to create an article and then use the 
Droppics  button in the article editor to create and insert the selected 
gallery folder into the article. 
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14.2.1 How to add a gallery to your webpage 

 You need to be editing an article to do this! 

The basic principle of adding a gallery to your webpage ( i.e., within an article) is to 
place your cursor where you would like your gallery to sit and then use the Images 
- Droppics button which sits underneath the editor screen to then insert your gallery. 

 

Clicking this button causes the Droppics application to appear in a popup screen 
where you can choose or add a gallery to add to your article. 

As you will see below, gallery images are shown in folders;  all you have to do is to 
select the folder you want to add to your webpage  and click the blue  Insert this 
gallery button which appears on the top of the right-hand column. 

 

 Note that this blue button is not visible to you if you have accessed the 
Droppics  system via the Component route!! 

14.2.2 Using the Droppics System 

 Whether you access Droppics  by going via the Components route via the Article 
route, when you first open Droppics,  you will notice it is split into three columns: 
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The first column  is where you will see folders and each folder represents a set of 
images.  The application calls these albums  (which we  think is a little bit confusing 
because otherwise we think they ought to be called galleries!).  You can create as 
many albums as you wish and each  should have a unique name so that you can 
quickly identify it amongst its peers. 

The second column is where you'll see the images inside the selected album.  You can 
add portrait or landscape images  to this space by dragging and dropping them or by 
using the blue Select Files button.  

The third and final column is where you will choose how the album will be displayed 
as a gallery by selecting one of the six available themes.  The default theme which 
looks like four squares  is ideal for most  purposes. 

This third column is also used to make choices about how each image appears,  for 
example, you will regularly use this third column to define the caption for the chosen 
image. Other options are available here but are not used regularly so don't worry 
about them! 
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14.2.3 Creating new albums 

New albums are created by clicking on the blue New Album button on the top left of 
the Droppics  panel: 

 

 When you do this, the system automatically creates a new folder for you at the top 
of the list and it will be labelled as "New gallery". 

14.2.4 Renaming the folder 

To rename a folder, hover your mouse over the folder name to see two small icons, 
one is a pen and the other is a trashcan.  Click on the pen icon to see that you can 
now rename the folder to something more suitable for your use. Try to create 
original and unique  folder names so that you can spot them later when you use 
them! 

 

14.2.5 Deleting a folder 

To delete  a folder and all its contents, hover your mouse over the folder and click the 
trashcan icon.  You will see a warning notice  asking you to confirm that you wish to 
delete the selected folder.  Click okay to do so. 

14.2.6 Adding images to your folder 

You can add images to your folder at any time  either by clicking on the blue  Select 
Files button or by dragging and dropping images into the dotted space, drop the 
image over the words "Drop images here to upload" to be sure!  
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If when you drag-and-drop files into that dotted area  you find that the files do not 
upload (i.e. nothing happens) then try again and drop the images directly over the 
words "Drop images here to upload". 

 

14.2.7 Putting images in a different order 

It is very easy to put images in a different order than the ones shown when you first 
upload them.  For example,  you may have a group of images of staff members and 
you want to show them in alphabetical order. When you upload them it's highly 
unlikely that they will be in alphabetical order and so you need a simple way of 
putting them in the right sequence.  All you have to do is to select and drag and drop 
it into the right place. You can do this over and over again until all images are in the 
sequence you wish them to be shown in.   

14.2.8 Adding a Caption to an image 

Sometimes,  but not always, you may need to add a caption to an image. An example 
of this is where you have images of staff members and you wish to put their names or 
titles underneath the image. To do this, select the image and the right-hand column 
will change to show the properties of the image. 

Then, scroll down the right-hand column to see the section  for Caption: 
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Type in the words you want to show as the caption for the image and then take 
the Show Caption tick box to enable the caption to be displayed. 

 Then, scroll down and click the blue Save Options button. 

 Note:  There is no feature for a description for your image therefore 
always try and keep the caption brief. If your caption is very long it will 
start to obscure the image when it is shown in the front of the website. 

14.2.9 Deleting an image 

 To delete an image from a folder simply select the image in question and the right-
hand column will appear with the properties for the image.  At the top of this column 
you will see a Delete Image button.  Click this button to delete the image from the 
folder. 
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15. Managing Users 
You need to have users with appropriate permissions to allow them to 
manage the website and its content. This section shows you how to create 
new users and work with existing users. 

15.1 Getting Started 

In the Control Panel of your web site choose Users >> Manage to reach the User 
Manager list of accounts (your view may look slightly different and have more or 
different accounts defined): 

 

15.2 Adding a new user 

Last Updated: 29 January 2024 Hits: 2 

In order to create a new user you will follow these steps: 

Press the New button in the toolbar to open the new user panel where you can enter 
the user data. 

 

Now, fill in the user details: 
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15.2.1 Key Fields 

Name - this field will contain the user's real name, like John Smith 

Login Name - this would be the user or login name to be used to log in to the site, like 
jsmith or yellowbird67 

Password - here you can enter a password that will be sent automatically to the 
user so he or she can log in. A good rule of thumb for choosing a safe password is to 
use lower case letters together with capitals and numbers while having a minimum 
length of six characters. A good example would be p9HWc0Ak! 

Confirm Password - here you have to reenter the previously chosen password just to 
make sure there were no typos in the first one 

Email - The email address associated with this account (this should be a valid 
account) 

Receive System E-mails – Set this option to "No". Only the Super-Admin will want to 
see these. 

User Status - here you have the possibility to Block a previously created user account 
without deleting it. This option might be useful for blocking users until they (or you) 
take a certain action. Simply set this option to Blocked if you wish to disable the 
account. 

Require Password Reset – If set to ‘Yes’, the first time the user logs in, they will be 
prompted to input a new password. 

15.2.2 Giving the User Permissions to Access the Administrator Control Panel 

Use the Assigned User Groups tab to choose the Group to assign your user to. This is 
crucial for the site's security so pay attention when setting this up! 

There is no golden-rule for choosing the user group except maybe for this one: "Keep 
the permissions as low as necessary". 

Normally, you wouldn't want to assign the Super Administrator or even Administrator 
role to just anyone. 
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In 99% of the cases you will assign your users to the "Manager" group, thus only 
allowing them limited choices when logged in at the back end of the site. 

If this user needs to fulfil ALL possible changes to the site, then a higher level of 
“Administrator” or the highest level “Super Administrator” will be appropriate. This 
last option has complete rights to affect the site. Below is a summary of the rights 
available to users at the back end of the website 

15.2.3 Types of User 

Manager 

• Can create new items 
• Can edit all other items, even those that are not published 
• Can publish items 

Administrator 

As Manager Group privileges plus… 

• Can create new users 
• Can install extensions 

Super-Administrator 

• Administrator privileges plus… 
• Can change site template 

• Can change global configuration 

You should leave the “Basic Settings” tab details as default 

You should leave the “User Profile ” tab details as default 

Once you are done entering all the information above, click the Save & Close button. 

The user will now receive an email (see below for example) with details of their new 
account. 

 

Hello username1234, 

You have been added as a User to [name of the site]. 
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This email contains your username and password to log in 
to http://www.domainname.com/ 

Username: username1234 

Password: yourpassword 

Please do not respond to this message as it is automatically generated and is for 
information purposes only. 

 

Assuming the account has not be set to “Blocked”, the new user will now be able to 
log in using the username and password you have set. 

15.3 Disabling/Banning/Deleting an existing user 

15.3.1 Disabling/Banning 

In order to disable or ban an existing user - not allowing them to login to the site - 
you must log in to the administration panel and open the User Manager. In the user 
list select the corresponding user by clicking on its name. In the newly opened panel, 
set the Block this User option to Yes and press the Save button. 

Please note that this method will not delete the user account but will only disable it. 
You can always re-enable it by setting the Block User option to No. 

15.3.2 Deleting a user 

We don't recommend deleting users - it can have an impact on 
legitimate content that they may have created in the past. We recomend 
Blocking their accounts instead. 

In order to delete a user from your database, log in to the control panel as described 
above and choose the User Manager function. On the opening page, select the 
checkbox to the left of the user's name you would like to remove and press the 
Delete button in the toolbar. 

http://www.domainname.com/
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Note that there are a number of more in-depth access rights that can be used to 
make the system even more flexible but, in a straight-forward website such as most 
small sites, these choices and configurations above are probably quite adequate. 
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16. Menus 
Menus are a key part of your website; a menu is a set of hyperlinks used for 
navigation of the website. Each menu item defines a hperlink to a page and holds 
settings that control what is displayed and what it looks like. 

In general, website menu items link through to one of the following types of page: 

- An article page 
- An SP Page Builder page (Use an advanced layout article - see separate 

section for more information) 
- A contact form page 
- A calendar page 
- An external website 

Within the websites that we create for you, these are the five most common types of 
page which we link to from menu items. 

This section of our help page system will describe what menus look like, how you can 
edit them and create new menu items. 

16.1 Where are Menus seen? 

Menus are found on every web page of your website. They also found in the control 
panel of your website. Let's look at a couple of examples. 

16.1.1 Menus on the front of your website 

As mentioned above, every website will have navigation menus; the great majority of 
these menus will be seen as a horizontal row of choices which allows visitors to 
navigate to different areas of your website. Normally, these choices keywords that 
visitors will understand and which will help them find the appropriate content that 
they're looking for because of the title keyword. Below is an example of our own 
website showing five key areas that we wish our visitors to explore: 
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If we zoom in on the menu you will notice that two of them show down arrow 
chevrons: 

 

These chevrons represent the fact that the top level menu items contain sub items 
and that the visitor can click the top level item to see those sub items: 

 

16.1.2 The “hamburger” menu view 

On Mobile devices and certain tablets with smaller screens might not be able to 
display all of the top level menu items in a menu. To overcome this, a well known 
approach has evolved whereby an icon is displayed instead of the menu items and 
this icon looks like a hamburger: 

 

The hamburger is used by mobile users and when clicked or touched on the screen it will 
expand to show the same menu items as above however they are displayed in a 



 

238 

vertical rather than a horizontal manner: 

 

Notice that the top two options still display a chevron which when clicked or touched 
will expand to show the sub items: 

 

16.1.3 Menus in the control panel of your website 

As previously described in our introductory sections, all control panels have menu 
options which are either horizontal or vertical depending upon the version of the 
Joomla platform you're using. Here's a recap: 

In Joomla 3, your control panel menu will look like this: 
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Meanwhile in Joomla 4,  your control panel menu will have this display: 

 

These of course are essentially the same apart from the orientation. 

16.2 Creating Menu Items 

Remember, menus are nothing more than a set of hyperlinks often to 
web pages of your website. So, you can understand that if you try to 
create a web link to something which doesn't exist then you are going to 
find a problem and an error will be reported. Therefore ensure that all of 
your articles and other content are ready for use before creating the 
menu items for them. 

16.2.1 Create a menu item to an article that you have created 

Let's use our earlier menu that we showed and use it to add a new menu item to an 
article that we have created. Here is the menu before we do any work to it: 
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Firstly, we need to consider which of the 5 areas seen in our menu will be the 
“Parent” for this new menu item; in other words, if  we wish to show a link to an 
article underneath “Courses”, then “Courses” will be the parent item and the new 
link will be a child item: 

 

Courses (Parent or Level 1 item) 

- Link to New Page (Child or Level 2 item) 

 

All items in menus are structured this way such that items at the top are 
always parent items (also known as level 1) and items underneath the 
parent are always known as child items (also known as level 2). 

Because we have decided to add our new menu item underneath Courses, it helps us 
now to create it within the website control panel. Here are the steps involved: 

1. In the control panel, click Menus > Main Menu [it will ALWAYS have a small 
house icon next to it to represent the HOME menu]. 
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2. You will now be presented with the Main Menu items list. 

 

3. Click on the New button at the top of the page. 
4. A new item page form is presented. 
5. In the Title field, type in the words that you wish to appear in the menu to 

represent the page you are going to reach. In our example, we will have a 
menu item which reads “My New Page”. 
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6. Now, you'll see a form area titled “Menu Item Type”. To the right of this field 
is a blue button marked Select.  

 

7. Click this button. 
8. A popup window appears showing you a number of different types of menu 

that you can add. Please don't be daunted by the number available! As a rule 
of thumb, you will only normally use one or two of them! 

 

9. Click on Articles, and the item will expand to show different forms of article 
that you might use for your page display. 
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10. The two most common options which are used are: 
a. Category Blog 
b. Single Article 

11. We only want to display one article when the menu item is clicked, then we 
should choose Single Article. 

12. The popup will disappear and return you to the new item form. 
13. Now, you'll see a new field has been displayed for you select which Article to 

show when the item is clicked. 

 

14. Click the blue Select button in the Select an Article field. 
15. A new popup appears showing your list of all of the articles that you have 

created. Normally these are shown with the most recent at the top. 
16. Select or use the Search box to look for the name of the article that you have 

created. If you search for it, it will appear on its own and you can then select 
it. 
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17. Now, the final stage is to set the menu item up to tell it which parent item it 
belongs to. 

18. On the right hand side of the form you will see a chooser called Parent Item. 
Click on this item and scroll through the list of potential parent items until you 
find the parent item you wish this new item to belong to. We want to show 
this new item under “Courses” so we choose that item: 

 

19. When you have chosen the parent item your form should look like this: 
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20.  You can now click the Save button and visit the front of your website to see if 
your new item has appeared.  

 

 

16.3 Moving menu items around 

From time to time you may find that you need to move menu items so they appear 
under different parents. The reasons for doing this will vary depending upon the 
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circumstances of your requirements however the principles applied always remain 
the same.  

You move menu items around within the menu manager. Again, let's reflect upon the 
way that the two different versions of Joomla display the way you can reach the 
menus: 

In Joomla 3, your control panel menu will look like this: 

 

 

Meanwhile in Joomla 4,  your control panel menu will have this display: 

 

These of course are essentially the same apart from the orientation. 

16.3.1 Steps Involved 
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The first thing we need to do is to navigate to the main menu area by clicking on 
Menus and then on to the Main Menu link which will show a house icon. This 
represents your home menu. Click on this item. 

16.3.2 The Menu Items List 

You will now reach the menu items list for the main menu. When you look at this list, 
you will notice that it is a vertical representation of your website's horizontal 
navigation, you will always see a Home item at the top which of course is a parent or 
level one item. You will also see other level one items with their child items 
underneath them, something like this: 

 

 

Moving items within a particular parent group is easy. Looking at the screenshots 
above notice that the three items underneath Home are not alphabetically 
sequenced and perhaps that's what you would like to do, or maybe you simply like to 
move things around underneath the parent item so they're in a more suitable 
sequence to fit your needs. 
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To do this, hover your mouse over the three vertical dots which appear on the line 
that you would like to move; when you do this, your cursor will become a crosshairs 
icon: 

 

While your crosshairs are showing you can drag and drop the selected item anywhere 
appropriate for you underneath that parent item. 

Note, it is not possible to drag and drop an item between different 
parents. 

 

You can move as many items as you wish into whatever sequence you need them as 
long as you move them within that parent group. 

16.3.3 Moving menu items between parents 

In order to move a menu item from one parent to another, you simply need to edit 
the child item that you wish to move.  Click on the title of the child item that you wish 
to move so that you can edit the item - the screen might look like this:  
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Now, move your cursor over the Parent Item choose a and select the new parent that 
you would like your menu item to belong to. 

Once you have chosen the correct parent, click on Save & Close. 

This will now take you back to the list of menu items. At this point, if you need to you 
can drag and drop The item so that it sits in a more suitable sequence under its new 
parent. 

16.4 Unpublishing Menu Items 

As time passes, you will find that certain menu items may no longer be required and 
therefore you will need to understand how to unpublish those menu items off so 
that the public can no longer see them. 

Unpublishing these items is simple. Using the ideas above, simply navigate to the 
main menu (shown with a house icon) and click it to show the list of menu items.  

Next, use the search feature to look for the menu item that you wish to unpublish. 
When you find it, you will notice that it shows a green tick to the left of the item 
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display. This means that the item is published and therefore will be visible to the 
public. 

 

To unpublish the item, simply click on the green tick to change it to a grey cross (in 
Joomla version three, this will be shown as a red cross) 

 

 

Having done this, the selected menu item will no longer be visible in the menu of 
your website. 

16.5 Hiding menu items 

Under Special circumstances, normally while you were testing a page, you might 
need to create a menu item and then immediately hide it so that it is not visible to 
the public. When you do this, two specific options will help you to reach the hidden 
page despite the fact it is not visible in the menu. 

As described above, open the Main Menu (showing the house icon) to see the list of 
menu items. Create your menu item as normal but before you save the menu item, 
follow these additional steps to make it hidden. 

Click into the Alias field which sits next to the Title field and type in a name that only 
you will know - make it easy to remember. Here is an example of one which is quite 
simple: 

 

We have chosen an alias of demopage. 

The second part of hiding the menu item lives underneath the Link Type tab: 
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When you click on the Link Type tab a set of special fields and values can be used to 
configure the item so it does not display in the menu.  

Scroll to the bottom fields of the page to see a toggle switch labelled Display in 
Menu. The default value for this toggle switch is yes as shown below. 

 

If you need to hide the menu item so that it is not displayed, click the toggle switch 
and set it to no: 

 

Now, you can save and close your menu item. 

16.5.1 Reaching hidden pages 

When you have hidden a page, as noted above it will not be visible in the menu. 
Think about where you added the menu item and which parent it belongs to. If for 
example the hidden item belongs to the Courses parent menu option, click on any 
other child option underneath courses and look at its web address. 

For example, if the web address of the courses page is: 

https://tapiochre.co.uk/courses 

You will be able to reach your hidden page by appending the created that you added 
to the courses web address so it will look like this: 

https://tapiochre.co.uk/courses/demopage 

https://tapiochre.co.uk/courses
https://tapiochre.co.uk/courses/demopage
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It's as simple as that. By creating an alias which is easy to remember but not 
particularly easy to guess and adding it as a suffix to the full web address including a / 
as shown in the example above, you can reach a hidden page. 
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